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Master CAD

YOUR RIGHTS AND OURS. This copy of master cad is
licensed to you. Youmaymakecopiesforyourownuseor for archival storage. You
may also sell your copy without notifying us. However, we retain copyright and other
property rights in the program code and documentation. We ask that MASTERCAD
be used either by a single user on one or more computers or on a single computer by
one or more users, if you expect several users of MASTER CAD on several
computers, contact us for quantity discounts and site-licensing agreements. Also if
you intend to rent this program, or place this program on a BBS, contact us for the
appropiate license and fee.

We think this user policy is fair to both you and us; please abide by it. We will not
tolerateuseordistributionof allorpartoiMASTERCAD or itsdocumentation by any
other means.

LIMITED WARRANTY: Lireturn foryour understanding of ourlegal
rights, weguarantee MASTER CAD willreliably perform asdetailed inthisdocumen
tation, subject to limitationshere described,for a periodof thirty days. If MASTER
CAD failstoperformasspecified, wewilleithercorrecttheflaw(s)within15working
days of notification or let you return MASTER CAD to the retailer for a full refund of
yourpurchase price. If yourretailer does notcooperate, return MASTER CAD tous.
While we can't offer you more cash than we received forthe program, we can give you
this choice: 1)you may have acash refund ofthewholesale price, or2)you may have
a merchandisecredit for the retail price, which you may apply toward buyingany of
ourothersoftware. Naturally, weinsistthatanycopyreturned forrefundinclude proof
of the date and price of purchase, the original program disk, all packaging and
documentation, and be in salable condition.

If the disk on which MASTER CAD is distributed becomes defective within the
warranty period, return it to usfor a freereplacement. Afterthe warranty period, we
will replace any defective program disk for $5.00.

We cannot be responsible for any damage to your equipment, reputation, profit-
making ability or mental or physical condition caused by the use (or misuse) of our
program.

We cannot guarantee that this program will work with hardware or software not
generally available when this program was released, or with special or custom
modifications of hardware or software, or with versions of accompanying or required
hardware or software other than those specified in the documentation.

Under no circumstances will we be liable for an amount greater than your purchase
price.

Please note: Some states do not allow limitations on how long an implied or express
warranty lasts, or the exclusion or limitation of incidental or consequential damages,
so some of the above limitations or exclusions may not apply to you.

UPGRADES AND REVISIONS.%you....
card, we will notify you if upgrades to MASTER CAD Becomeavail
upgrades and fixes, return the original disks to us with$5.00. For major revisions, the
upgrade fee is typically 15-20% of the original suggested retail price.

FEEDBA C/K: Customer comments areVERY important tous. We think that
the use, warrantyand upgradepoliciesoutlinedabove are among the fairest around.
Please let us know how you feel about them.

Many of the program and documentationmodificationswe make result from customer
suggestions. Please tell us how you feel about MASTERCAD - your ideas could make
the next version better for all of us.

COPYRIGHT NOTICE: The MASTER CAD program
documentation are Copyright © 1987 I.N.D.I.
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COMPUTERS

An Afar/ 57with 1 MEG of RAM (Color or Monochrome
Monitor) is required to use MasterCAD. A second disk
drive is recommended.

PRINTERS

EPSON FX80 COMPATIBLES

You can install any G-DOS compatible driver on the
Master CAD disk.

PLOTTERS

HEWLETT PACKARD™ Color Pro, 7550, 7580

EPSON is a trademark of EPSON CORPORATION. HEWLETT PACKARD is i

trademark of HEWLETT PACKARD COMPANY.
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Master CAD

W elcome to Master CAD, the CAD system for
theAtari ST. MasterCADusesa simplebutrevolutionary
conceptin graphicdesignwhichallowstheuser to project
a design made in two dimensions into 3-D. Master CAD
also offers you the ability to generate spun objects from
two dimensions and project them into 3-D, revolving
around the sameaxis. ButMaster CAD is more than just
a design tool; it is also a system for 3-D design analysis.
The program includes a complete set of "Tools", which,
combined with the ease of use, makes designing a simple
and enjoyable task.

With your AtariSTand Master CAD you can:

>- Produce objects in 2-D and 3-D using pull-down
menus, dialog boxes and the mouse, using very
few commands from the keyboard.

>~ Move, copy, rotate andflip any object, horizontally
or vertically; change their proportions and tex
tures; and export or import them to and from other
object-files.

*>~ Observe the objects from various viewpoints and
viewangles, external or internal, transparent or
solid.

2 Introduction



Chapter 1: Introduction

Observe the objects in orthogonal, perspective,
axonometric, and oblique projections from any
angle.

To use Master CAD you will need to know how to use the
Atari ST, the mouse, and the GEM interface. If you are not
familiar with these, refer to your ST manual. Fluency in
the use of the GEM interface will allow you to use Master
CAD with greater ease and satisfaction.

We hope you enjoy Master CADI

Note: Before proceeding please read the
README file on the Master CAD disk.
It contains updated information that was
not available at the time this manual went
to press.

Introduction 3
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Master CAD

1 obegin, turn on your computer and wait for the
GEMDesktop toappear. StartMasterCAD, byusingthe
mouse to move the cursor arrow over the DESIGN.PRG

icon. Click the left mouse button once. Notice that the
DESIGN.PRG icon turns black to indicate that it has been

selected.

Fig. 2 Click on DESIGN.PRG

Desk File View Options

*l 1 A:\ " i
371725 bytes used in 18 itens.

S AUTO 11-20-85 12:30 an Q_
a COLOR RSC 11-20-85 12:30 an

a DESIGN 11-20-85 04:32 an

M M0N0CR0M RSC 11-20-85 12:32 an

M OUTPUT 11-20-85 12:00 an

ASSIGN SYS 536 11-20-85 12:33 an

CLIPB OBJ 2572 11-20-85 12:48 an

CLIPB PI3 32034 11-20-85 12:25 an

CLIPB1 PI3 32034 11-20-85 01:52 an

CONTROL ACC 15445 11-20-85 12:33 an

< DESIGN PRG 1655BZ 11-20-85

DESKTOP INF 491 11-20-85 04:44 an*
FX80 SYS 50645 11-20-85 12:34 an

MASTER FNT 4656 11-20-85 12:35 an

META SYS 6625 11-20-85 12:35 an

OUTPUT PRG 31617 11-20-85 12:35 an

PRINT RSC 16932 11-20-85 12:35 an

PRINTCOL RSC 12568 11-20-85 12:35 an "«
«l k V,

Move the cursor to the File drop down menu and position
the arrow over the word Open and click the left mouse
button.

Chapter 1 — Getting Started
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Chapter 1: Getting Started

F/g. 3 Select Open in ffie FILE menu

Desk 1 MieM Opt ions

81 UMl^BJBJBJ^I
Show Info,.. *

New Folder...

Close

Close Window

a:\ £3

371725 itens,

•A AUT

M COL

;o DES

:o MON

:•: out

11-20-85

11-20-85

11-20-85

11-20-85

11-20-85

12:30 an

12:30 an

04:32 an

12:32 an

12:00 an

12:33 an

12:48 an

12:25 an

01:52 an

12:33 an

ASSIGN SYS 596 11-20-85

CLIPB OBJ 2572 11-20-85

CLIPB PI3 32Q34 11-20-85

CLIPBl PI3 32034 11-20-85

CONTROL ACC 15449 11-20-85

DESIGN PRG 165502 11-20-85 iVi.u an • • iniMmr -.11.AW:."-T«^EK*

DESKTOP INF 491 11-20-85

FX80 SYS 50645 11-20-85

MASTER FNT 4656 11-20-85

META SYS 6629 11-20-85

OUTPUT PRG 31617 11-20-85

PRINT RSC 16932 11-20-85

PRINTCOL RSC 12568 11-20-85

04:44 an

12:34 an

12:35 an

12:35 an

12:35 an

12:35 an

12:35 an

01 1* t,

If you are already familiar with the Atari ST and the GEM
Desktop, you are probably aware of a shortcut: Move the
arrow cursor over the DESIGN.PRG icon and rapidly
click the left button twice. Master CAD's DESIGN

program will then load and run.

Chapter 1 — Getting Started
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Fig. 4 Requiredfiles in Master CAD

Desk File View Options

h:\
313196 bytes used in 22 itens.

S AUTO 84-22-87 12:BI an

10 COLOR RSC B4-2Z-87 12:23 an

K MDNOCROM RSC 04-22-87 12:24 an

DESIGN PRG 165502 05-38-85 02:27 an

FX80 SYS 5B645 12-11-87 03:41

OUTPUT PRG 31617 12-11-87 03:42

PRINT RSC 16332 12-11-87 03:42 nn

CONTROL ACC 15449 04-22-87 12:25 of)

PRINTCOL RSC 12568 12-11-87 83:42 pn
METB SYS 6623 12-11-87 83:42 pn

MASTER FNT 4656 B4-22-87 12:25 an

MAZE1

MAZE2

MAZE8

MAZE3

MAZE4

TEST1

PRF

PRF

PRF

PRF

PRF

PRF

ASSIGN SYS

1432

1432

1432

1160

824

600

12-29-87

12-29-87

12-29-87

12-23-87

12-29-87

12-29-87

03:58 pn
04:80 pn
04:17 pn
04:03 pn

04:05 pn
04:54 pn

596 12-11-87 83:41

Chapter 1 — Getting Started
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The Master CAD

Drafting Board

MENU:

This is also referred to as the Menu Bar. It is found at the

top of the screen, and contains all the menus available to
the user at a given moment. When working on the
workscreen board the menu bar will disappear. Run the
cursor to the top of the screen and it will return.

WORKSCREEN:

The available drawing space.

GRID:

An overlay of reference points to help in design.

MONITOR:

A display of information at the bottom of the screen that
indicates where you are in the program and what is
happening.

The Drawing Board
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Fig. 5

VIEW:Left i-Yi 11.58 DY: 8,80 BRIGHT: 0,00 DIST.: 0.00 FREEllOO'/ M
TDOLiLine Z:-1.85 DZ: 0.00 « LEFT : 0.08 ANGLE: 0.08 Z00M:100 T

The Monitor Displays:

VIEW: Indicates theorthogonal view you are working
on.

TOOL: Shows the tool you are working with.

X: The absolute X coordinate measured from the
origin. Also lets you know the radius of a
circle or theX (horizontal) radiusof anellipse.

Y: The absolute Y coordinate measured from the
origin. Also lets you know the radius of a
circle or the Y (vertical) radius of an ellipse.

10 Chapter 1 — Getting Started
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The absolute Z coordinate measured from the

origin. Also lets you know the radius of a
circle or the vertical radius of an ellipse.

DX: The relative X coordinate measured from the

first user-defined point. Also lets you know
the radius of a circle or the X horizontal radius

of an ellipse.

DY: The relative Y coordinate measured from the

first user-defined point. Also lets you know
the radius of a circle or Y vertical radius of an

ellipse.

DZ: The relative Z coordinate measured from the

first user-defined point. Also lets you know
the radius of a circle or the vertical radius of an

ellipse.

UP: Shows the height of the upper limit plane. If
the plane is inclined, indicates the vertical
variable height of the cursor position.

DOWN: Shows you the height of the bottom limit
plane.

FRONT: This is the reference Y coordinate of the front

limit plane.

BACK: This is the reference Y coordinate of the back

limit plane.

The Drawing Board 11
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LEFT: This is the reference X coordinate of the front
limit plane.

RIGHT: This is the reference X coordinate of the front

limit plane.

#:

/:

Indicates that you are working in CutPlanes
mode.

Indicates that you are drawing over the
Contain Plane.

DIST: Shows you the distance between the first user-
defined point and the cursor position.

ANGLE: Shows you the angle between the line you are
drawing and the horizontal.

FREE: Percentage of remaining free memory.

ZOOM: Indicates the current zoom value.

MT: Shows that you are working in Metric units of
measure.

IN: Shows that you are working in English (inch)
units of measure.

Now that you know more about the Drafting Board
Monitor Display, let's take a closer look at it and some of
the Menu Selections!

12 Chapter 1 — Getting Started
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Master CAD

An this section of the manual, you will beintro
duced to the exciting world of Computer Aided Design
(CAD). You will be given a guided tour of the different
modules of Master CAD using a structured tutorial: we
will present a series of procedures which can be used
independently or as building blocks to form a chain of
instructions for more complex procedures.

To begin your tutorial, you should be in the main work-
screen of the DESIGN program (refer to page 6 of this
manual).

14 Chapter 2 — Tutorial
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Procedure: Opening Menus

Move the mouse and follow the cursor's movement on the

workscreen. Now move the cursor to the upper part of the
screen toward the Menu Bar. When the cursor touches the

top of the screen the Menu Bar will appear and the nearest
menu will drop down and display its contents. Position the
cursor over the View menu. It will drop down and show
the choices available to you. This procedure is quite
simple and will be called opening the View menu (or
whatever menu this tutorial indicates).

Fig. 6 Select Left in the VIEW Menu

Desk File Control I'Jf^l Planes Tools Mode Select Process 3-D

VIEW:Plan

TOOLiLine

•5.85

9.50

Plan
Front

Back

OX:

DY;
0,00
o.ao

» UP
« DOWN

DIST.:
ANGLE:

0.00
0,00

FREE: 100'/! M
ZOOM:100 T

Move the cursor over the word Left and click the left
mouse button. For the purposes of this tutorial this action
will be called just that - click the mouse button, or select.

Opening Menus 15
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Notice in theMonitor, at the lowerpartof the screen, that
Master CAD is telling you that you are in theLeft view
mode.

Fig. 7 Left is now recorded in the Monitor as the View Mode

Desk File Control flffll Planes Tools Mode Select Process 3-D

yiEW:Leftw. V: 5.80 DY: 0,00 « RIGHT: OTOQDIST.: 0.00 FREE: 100'/ Ml
TOOLiLine Z: 14,90 DZ: 0.00 « LEFT : 0.00 ANGLE: 0.00 Z00M:100 T|

Master CAD has two menu bars. To access the second bar,
openthe3-D menu andwatch how themenu titles change
on the menu bar.

Fig. 8 2D Menu Bar

Desk File Control View Planes Tools Mode Select Process 3-D ^

16 Chapter 2 — Tutorial
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Fig. 9 3D Menu Bar

Desk FILE VIEWPOINT VIEUMODE PROJECTION 2-0 *

Opening Menus 17
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Procedure: Cube

Desk

Open the File menu and select the New option. If the
Attention window appears, select Continue (Warning:
This will delete anything currently in the WORK-
SCREEN.

Open
Append
Inport
Save
Save as

Draft Print
Save Screen

Quit

Fig. 10 Select New from the File Menu

Control VieM Planes Tools Mode Select Process 3-D

jVIEH:Plan
ITQOLiLine

X:-10,20
Y: 6,05

DX:

DY:
0.00
0,00

8 UP

a D0UN
3,00
0,00

DIST.:

0NGLE:

0.00

0,00

FREEllOOZ

ZOOM:100 Tl

Sub-Procedure: Normal Planes/Plan

Check the monitor window to make sure you are
working in the Plan view. Open the Planes menu
and select the Normal option. The Menu Bar will
change to read SET CUT PLANES. Notice in the
monitor that you are in the Front view. Move the
cursor towards the bottom of the screen and watch

the broken horizontal line that follows it to indi

cate the tracing of the plane. You now control a
horizontal plane on the screen, which you may
raise or lower by moving the mouse.

18 Chapter 2 — Tutorial
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Master CAD

VIEH:Front X:
TDOLiLine Z:

Move the plane until the coordinate Z is equal to
zero (Z:0.00) and click the left mouse button to
confirm this operation. You have now defined a
horizontal plane with the elevation Z=0.

Fig. 13 Set the first plane at Z.0.00

3,10

0,00

DX:

DZ:

SET CUT PLANES

0,00

0,00

tt FRONT: 0.00
n BACK : 0,00

DIST,:
ANGLE:

l),00

0,00

FREE:100Z M
ZOOM:100 T

Move the second plane to (Z:4.00) and click the
mouse button to confirm. The Planes Mode Selec

tion box will appear. Click the mouse on OK.

20 Chapter 2 — Tutorial
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Chapter 2: Tutorial

Fig. 14 Set the second projection plane at 2:4.00

SET CUT PLANES

_l L
' "v

VIEW:Front X: 2,55 DX: 0,50 « FRONT: 0,00 DIST,: 4.08 FREE:1Q0Z M
T00L:Line Z: 4,00 DZ: 4,05 u BACK : 0,80 ANGLE: 82.96 Z0OM:10O T

VIEW:Front X: 2.55
T00L:Line Z: 4.00

Fig. 15 Select CUT from the
Planes Mode Selection Box

SET CUT PLANES

Planes Mode Selection

0 HI-CONTAIN

© LOU-COHTAINl

I OK il | CANCEL |

DX: 0.50
DZ: 4,05

tt FRONT: 0.00 DIST.: 4,08 FREEilBOZ M
tt BACK : 0,00 ANGLE: 82.36 ZOOM:100 T

Cube 21
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Once the planes are defined, Master CAD shows
you the Planes Mode window. Press OK to use the
Cut Mode. You now have two projection planes,
with Z=0 as the base and Z=4 as the top. All
drawing will be projected between these planes.

You have now completed the sub-procedure. We will
continue to build the cube.

Open the Tools menu and select the Rectangle option.

Fig. 16 Select Rectangle from the Tools Menu
Desk File Control View Planes dig Mode Select Process 3-D

VIEW:Plan X:-1.10
T00L:Line Yi-5.15

DX:
DY:

0.00
0,00

Line

Regular Polygon(circfe)

Polyline
Polygon
Clockwise Arc

Counterclockwise Arc

Text

tt UP

» DOWN
-0.05
4.00

DIST,:
ANGLE: .00

FREE:100Z M
ZOOM:100 T

Place the cursor in the center of the screen and click the

mouse button to draw. Move it a short distance and notice

how the rectangle is drawn on the screen.

To make a 4m x 4m rectangle, move the cursor until the
monitor indicates DX:4.00 and DY:4.00, and click the

mouse button to confirm. You have now defined a 4m x

4m x 4m cube, delineated from a base plane of Z=0 and
with a top plane of Z=4.

22 Chapter 2 — Tutorial
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Master CAD

Procedure: General View

Open the View menu and select the Plan view. You will
see the plan of the object developing on the screen (See
Fig. 18).

Fig. 18

Desk File Control »'>ij:i Planes Tools Mode Select Process 3-D

Front

Back

Left

Right

VIEH:Plan X:-4,75 DX: 0.00 tt UP : 4.00 DIST,: 0.00 FREE:39V. M
T00L:Rect, Y: 8,90 DY: 0.00 » DOWN ;-fl,05 ANGLE: 0,00 Z00M:100 T

Open the View menu, select the Frontview and observe
(Fig. 19).
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Fig. 19

Desk File Control BHBI Planes Tools Mode Select Process 3-D

IPlan I

Back
Left
Right

VIEWiFront X:-4,30 DX: 0.00

T00L:Rect. Z: 15,00 DZ: 0,00

» FRONT: 0,00 DIST,: 0,00 FREE:33X M
» BACK : 0,00 ANGLE: 0.00 ZOOM:100 T

Open the View menu, select the Left view and observe
(Fig. 20).

General View 25



Master CAD

Fig. 20

Desk File Control Vili'.t Planes Tools Mode Select Process 3-D
Plan

Front

Back

VIEW:Left Y: 5.15 DY: 0.00 » RIGHT: 0.00 DIST,: 0,00 FREE:39Z M
T00L:Rect, Z: 16,30 DZ: 0,00 » LEFT : 0,00 ANGLE: 0,00 Z00M:100 t|

Open the 3-D menu and observe the object in perspective
(Fig. 21).
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Desk FILE VIEWPOINT

Fig. 21
VIEWMODE PROJECTION 2-0

\

"^^^^^

^^~^ y

Open the Viewpoint menu, select Horizontal, and notice
how the menu bar disappears and the following message
appears: SET HORIZONTAL VIEW POINT (Fig. 22).

General View 27



Master CAD

Fig. 22

Desk FILE VIEWPOINT

Horizontal

1 VIEWMODE PROJECTION 2-D

Vertical

Conbined

Autoview

Lens

"~"^--^___

_._-—-"

The cursor has also been changed to a large crosshair made
of intersecting broken lines. The mouse controls this
crosshair.
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VIEW:Plan
TOOLlRect.

X:-13,30
Y:-3.70

Fig. 23 Set the Horizontal
ViewPoint...

"SET HORIZONTAL VIEW POINT

DX

DY

0.00
0,00

» UP
« DOWN

4.00

-0,05

DIST,:

ANGLE:

3,00

0,00

FREE:33* M
ZOOM:200 T

Place the crosshair center near the bottom and to the left

of the object and somewhat away from it, and click the
mouse button to fix the point of view. You have now set
the observer's plan position. Move the mouse and notice
how the indicator rotates according to the fixed position.
Also notice the message SET HORIZONTAL VIEW
ANGLE.

General View 29



Master CAD

Fig. 24 ..And the HorizontalView Angle

SET HORIZONTAL VIEW ANGLE

VIEWiPlan
T00L:Rect,

X:-5,40

Y: 2.80
DX: 14.60
DY: 14.50

tt UP

» DOWN
4.00

-0.05
DIST.: 20.58
ANGLE: 44.80

FREE!33Z M
ZOOM:200 T

30

Fig. 25 And Observe the new view
JJesk FILE VIEWPOINT VIEWMODE PROJECTION 2"D

Now move the cursor inside the object to indicate the view
direction, click the mouse button to set it and notice the

perspective of the object developed on the workscreen.
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Fig. 26 Set the Vertical
View Point (the Elevation)

1 SET VERTICAL VIEW POINT

VIEW:Front X:

TOOLiRect. Z:
31.30
25.60

DX:
DZ;

0.00
G .00

tt FRONT:

n BACK

0,00
0,00

DIST.

ANGLE:

0,00

0.00

FREE:33H M
ZOOM:200 T

Open the Viewpoint menu again and select the Vertical
option. An elevationof the object will appear as well as
a broken horizontal line which indicates the height of the
observer's viewpoint.

General View 31



Master CAD

Fig. 27 And the Vertical ViewAngle

SET VERTICAL VIEW ANGLE

VIEW:Front X:

T00L:Rect. Z:

1.30

1,70

DX:

DZ:

20.10

20,50
» FRONT: 0,00

» BACK : 0,00

DIST,:

ANGLE:

28.71

45.56
FREE:33Z M

ZOOM:200 T

32

Fix the desired height, click the mouse button to set it, then
aim the indicator at the object, click the button again to
complete the operation, and you will be able to observe the
object in perspective!

Open Viewmode, selectFilledPlanes and the object will
change from transparent to solid on the workscreen.
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Master CAD

This ends the exercise. You may save this sample if you
wish by selecting Save As from the FILE menu and
naming the Object.

Fig. 30 Select Save As and enter a name
Desk tttCj Control View Planes Tools Mode Select Process 3-D

New

Open
Append
Inport
Save

Draft Print

Save Screen

Quit

VIEWiPlan
TOOLiRect.

X: 1.80
Y:-1.00

DX:

DY:

4.00

4.05

tt UP

» DOWN

3.00

0.00
DIST.:
ANGLE:

5.63

45.36
FREEUOOX M
ZOOM:IBB T

If you plan to continue after saving your work, select New
from the File menu.
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Procedure: Cylinder

Unless you are using this procedure as part of another

process, open the File menu and select the New option. If
theAttention window appears, select Continue (Warning:
This will erase anything currently on the Work Screen).

Sub Procedure: Normal Planes/Front

Open the View menu and select Front (Fig. 31).
Observe in the monitor that you are working in
Front view.

Fig. 31 Select Front

Desk File Control >.ti-:i Planes Tools Mode Select Process 3-D

Plan

Back *
Left

Right

VIEWiPlan Xl-2.15 DX: O.QQ HUP :3,00 DIST,: 0,00 FREEliQD'/ M W'g]
TOOL.'Line Y: 3,75 DY: 0,00 » DOWN : 0,00 ANGLE: 0,00 Z00M:100 T

Cylinder 35



Master CAD

Open the Planes menu and select Normal. No
tice in the monitor that you are working in the Plan
view.

Fig. 32 Select Normal
Desk File Control View Tools Mode Select Process 3-D

VIEWiFront X:-3,70 OX: 0.00 » FRONT: 0,00 DIST,: 0.00 FREE:i00Z M
T00L:Line Z: 14,30 DZ: 0,00 tt BACK : 0,08 ANGLE: 0.00 Z00M:100 T

36

Move the cursor down and a broken horizontal line

will appear, indicating the tracing of the plane.
You now control a vertical plane which you can
move forward or backward as you wish.
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Fi#. 33 Setting a Plane

SE r CUT PLAN

i j

:S

V

T
[EN
JOL

:P1

ILI
an

ne

X:

Y:

0

4

80

30

D

D

x:

Y:

0.

0.

00

00
» UP
tt DOWN :

3.00
0.80

(1ST.: 0
INGLE:

,00

0,00
FREEilOOZ 1

ZOOM:100 T

Move it until the Y coordinate reads Y:1.00 and

click the mouse button to set the position for this
plane. You have now defined a vertical plane with
the position Y=l.

Cylinder 37



Master CAD

VIEW:Plan

TOOLiLine
X: 0,30
Y: 5,00

Fig. 34 Set planes at Y.1.00 and Y.-5.00

SET CUT PLANES-

DX:
DY:

0.30
4,00

9 UP

tt DOWN
3,00
0,08

DIST,: 4.01
ANGLE: 85,71

FREEilBOZ M
ZOOM:100 T

Move the second plane to Y:5.00 and click the
mouse button to define its position. The Planes
Mode Selection box will appear, click the mouse
on OK.

Once the planes are defined, Master CAD again
shows you the Planes Mode window. Press OK to
use the CutMode. You now have a plane at Y=5
and a second plane at Y=l.
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Fig. 35 Press Ok in the
Planes Mode window

SET CUT PLANES

Planes Mode Selection

1 l=t 1̂ ^UQ^H

1 —- I
|HP 11 BACK-CONTAIN |

L.pH..j| FRONT-CONTAIN 1

I OK ^J |CANCEL |
I

1 i

VIEW:Plan
TOOL:Line

X: 0,38

Y: 5.00

DX: 0,30

DY: 4.00

tt UP

» DOWN
3,00

,88

DIST,: 4.81

ANGLE: 85,71
FREEllOOZ M
ZOOM: 100 T

This completes the Sub Procedure. Now we will build the
cylinder.

Cylinder 39



Master CAD

Open the Tools menu and select RegularPolygon (Fig.
36).

Fig.36 Select Regular Polygon
Desk File Control View Planes jTMH Mode Select Process 3-D

Line

Rectangle

Polyline
Polygon
Clockwise Arc
Counterclockwise Arc

Text

VIEW:Front

T00L:Line

X: 11,15

Z: 12,30

DX: 0.00

DZ: 0.00

» FRONT:
tt BACK :

5.00

1,00

DIST,:

ANGLE;

0,00

0,00

FREEilQOZ M

ZOOM:100 T

40

Place the cursor in the middle of the screen and click the

mouse button once to set the center of the circle. If there

is another preset object on the screen, set the circle center
reasonably apart from the other figure, so that they do not
collide.

Chapter 2 — Tutorial

^

~

^

~



M

_

_

_

-

_

Chapter 2: Tutorial

Move the mouse and observe the circle forming around
the center point. Choose the form and size that you wish
and click the left mouse button to define the object.

Fig. 37 Drawing the Oval

._-— _^

/'" \
( )
\

—~— —-" .!-

VIEWiFront X: 4.60 DX: 4.80 « FRONT: 5.00 DIST.: 5,24 FREE:100'/ M
T00L:Circ, Z: 4.35 DZ: 2.10 « BACK : 1,80 ANGLE: 23,63 Z00M:100 T

Execute the procedure for GENERAL VIEW (refer to
page 24).

Cylinder 41
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Chapter 2: Tutorial

Fig. 40 ...or Left...

Desk File Control I'il-Jil Planes Tools Mode Select Process 3-D

VIEW:Front X:-4,70 DX: 0.00 tt FRONT: 5.00 DIST,: 0.00 FREE:33X M
T00L:Circ. Z: 16,50 DZ: 0.00 tt BACK : 1,00 ANGLE: 0,00 Z0QM:100 T

VIEW:Left Y: 3,80 DY: 0,00 «» RIGHT: 0,00 DIST,: 0,00 FREE:33X M
T0OL:Circ, Z: 13,20 DZ: 0,00 tt LEFT ! 0,00 ANGLE: 0,00 Z00M:100 T

Fig. 41 To view as you wish

Cylinder 43



Master CAD

Fig. 42 Set the Horizontal View Point and Angle

'SET HORIZONTAL VIEW POINT

--4

VIEW:Plan X: 25.30 DX: 0,00 « UP : 3.00 DIST.: 0.00 FREE:33Z M
TOOLlCirc. Yi-7.50 DY: 0,00 « DOWN : 0,00 ANGLE: 0,08 ZO0M:20O T

Fig. 43 Observe the results
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Fig. 44 Set a new Vertical View Point..
SET VERTICAL VIEW POINT

—

VIEW:Front X:-10.30 DX: 0,00 » FRONT: 5,00 DIST.: 0.00 FREE:33Z M
TOOLiCirc. Z:-1.60 DZ: 0,08 tt BACK : 1,00 ANGLE: 0.00 ZOOM:200 T

Fig. 45 And View Angle

"SET VERTICAL VIEW ANGLE

VIEW;Front X: 8.58 DX: 30.50 tt FRONT: 5,00 DIST,: 31,83 FREE:33Z M
T00L:Circ. Zi 7.80 DZ: 3.30 « BACK : 1.00 ANGLE: 16.36 Z00M:200 T

Cylinder 45



Master CAD

Fig. 46 ...and experiment!.'

Fig. 47 Practise using
different elevations...
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Master CAD

Fig. 50 ...And/or Fill Planes from the ViewMode Menu...

Fig. 51 ...You can even place yourself inside the cylinder!! —
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This ends the exercise. You may save this sample if you
wish (you will be using it later in the tutorial), then
continue to the next exercise. If you plan to go on after
saving your work, select New from the File menu.

Cylinder 49



Master CAD

Procedure: Polyline

Unless you are using this procedure as part of another
process,open the File menuand selecttheNewoption. If
theAttention window appears select Continue (Warning:
This will erase anythingcurrentlyon the Work Screen).

Sub-Procedure: Normal Planes/Left

Open the View menu and select Left (Fig. 52).
Note in the monitor that you are working in Left
view. Open the Planes menu and select Normal
(Fig. 53). Note in the monitor that you are in the
Plan view. Move the cursor to one side and

observe the broken vertical line that appears on the
workscreen that indicates the tracing of the plane.
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Fig. 52 Select Left..

Desk File Control flBTI Planes Tools Mode Select Process 3-D
Plan
Front

Back

VIEWlPlan X:-4.15 DX: 0,00 « UP ! 3.00 DIST,: 0,00 FREE:10G'/ M
T00L:Line Yl-0.05 DY: 0,00 tt DOWN : 0,00 ANGLE: 0,00 ZOOMilOO T|

Fig. 53 Then Normal...

Desk File Control View IJHil=U Tools Mode Select Process 3-D

Plan Angled
Front Angled

VIEU:Left Y: 3.35 DY: 0,00 » RIGHT; 0.00 DIST.: 0.00 FREE:100'/ M
T00L:Line Z: 13.15 DZ: 0,00 8 LEFT : 0,00 ANGLE: 0.00 Z00M:100 T|

Polyline 51



Master CAD

-J\

I

You now control a vertical plane which you may
move as you like.

Move it until the X coordinate reads X:0.00 and

click the left mouse button to set the position of
this plane.

Fig. 54 Move to X.0.00 and click to set

SET CUTl PLANES

I

VIEWlPlan X: 0.00 DX: 0.00 tt UP : 3.00 DIST.: 0.00 FREE:100Z M
TOOLiLine Y: 5.10 DY: 0.00 tt DOWN : 0.00 ANGLE: 0.00 ZOOMilOO T

You have defined a vertical plane with the position
X=0.

Move the second plane to the right, to X:5.00, and
click the left mouse button to define the plane's
position.

Chapter 2 — Tutorial
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._i

i

VIEWlPlan

(TOOLlLine
5,00

4.45

DX:

DY:

Fig. 55 Define the second
plane at X.-5.00

SET CUT PLANES I

5.05

0,60

tt UP

tt DOWN
3,00
0.00

DIST,:

ANGLE:

5.03

6,78

FREEilOOZ M

ZOOM:100 T|

Polyline 53
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Master CAD

~l\

Once the planes are defined, Master CAD shows
you the Planes Mode window. Press OK to use the
CutMode. You have now a first plane at X=5 and
a second plane at X=0.

Fig. 56 Select OK in the
Cut Mode Dialog Box

SET CUTi PLANES I

I

Plane Mode Selection

(9 iRIGHT-CONTAINl

LEFT-CONTAIN

CANCEL

VIEWiPlan

TOOLiLine

5,00

4,45

DX: 5,05

DY: 0,60

« up
tt DOWN

3,00

0,00

DIST.:

ANGLE:
5.03
6,78

FREE:100Z M

ZOOM:100 T

You have now completed the sub-procedure. We will
continue to build the polyline object.
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Chapter 2: Tutorial

Open the Tools menu and select Polyline (Fig. 57).

Fig. 57

Desk File Control View Planes lfp)fi M°de Select Process 3-D

VIEW:Left
T00L:Line

Y:-4,15
Z: 6.75

DY: 0,08
DZ: 0,00

Line

Rectangle
Regular Polygon(cirde)

Polygon
Clockwise Arc
Counterclockwise Arc

Text
Din

« RIGHT:
n LEFT :

5,00

•8.05

DIST.:
ANGLE:

0,00
0,00

FREE: 33'/. M
ZOOM: 100 T|

Place the cursor at some point on the left side of the screen
and click the mouse button to begin drawing. You will
notice the line forming according to its point of origin and
the position of the cursor. Now move the cursor a little
above and to the right of the point of origin. Click the
mouse button to confirm. Move the mouse and observe

the new line being drawn from the end point of the first
line. Repeat the procedure as you wish. To free the cursor
and complete the polyline, click the right mouse button.
The line will detach from the cursor.

Polyline 55



Master CAD

VIEW:Left

TOOL:Pline

Y:-10,45

Z: 2.20
DY: 0.00
DZ: 0.00

Fig. 58

/•""

tt RIGHT:

tt LEFT :
5.08

0.85

s
/

X
\

\
\

\

DIST,:

ANGLE:

0,00

0.00
FREE:33Z M
ZOOM:100 T

Execute the GENERAL VIEW procedure (refer to page
24).

This ends the exercise. You may save this sample if you
wish, then continue on to the next exercise. If you plan to
continue after saving your work, selectNew from the File
menu.
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w Procedure : Hexagonal Prism

Unless you are using this procedure as part of another
process, open the File menu and select the New option. If
the Attentionwindow appears, select Continue (Warning:
This will erase anything currently on the Work Screen).

Sub-Procedure: Front-Angled Planes/Plan

Open the View menu and selectPlan. Youwill see
in the monitor that you are working in Plan view
(Fig. 59).

Fig. 59 Select Plan from the View menu

Desk File Control I'JI-J!! Planes Tools Mode Select Process 3-D

•3
Front

Back

Left

Right

VIEUiPlan X: ~3.30 DX: Q.00 « UP : 3,00 DIST,: 0.00 FREEUOOZ M

T00L:Line Y: 8,75 DY: 8.80 n DOWN : 0,00 ANGLE: 0,00 Z00M:100 T

Hexagonal Prism 57



Master CAD

Open the Planes menu and select the Front
Angled option (Fig. 60). Observe in the monitor
that you are working in Front view.

Fig. 60

Desk File Control View PHiM-i Tools Mode Select Process 3-D

VIEW:Plan X:-3,25
TOOLiLine Y: 8.75

Nornal

. •••'

"TEH![•••|iB^.iik:ti-i'B.

Side Angled *

DX: 8.00
DY: 8.GO

tt UP : 3.00 DIST.: 0.00 FREE:100Z M

t* DOWN : 0,00 ANGLE: 0.00 ZOOM:100 T

Move the cursor towards the bottom of the screen

and observe the broken horizontal line that ap
pears on the screen which indicates the tracing of
the plane.
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Chapter 2: Tutorial

VIEW:Front X:
TD0L:Line Z:

You now control a horizontal plane that you can
raise or lower as you wish. Move it until the Z
coordinate reads Z:0.00 and click the mouse but

ton to set the first position point of this plane.

Fig. 61 Set Cut Plane at X:6.00, Z:0.00

6,00

0,00

DX:

DZ:

SET CUT PLANES

i i
I '

6.00

0,00

» FRONT

n BACK

0,00

0,00

DIST,:

ANGLE:

6.00

0.00

FREE:100Z M

ZOOM:100 T

Hexagonal Prism 59



Master CAD

Move the mouse and notice that the broken line

rotates around the fixed point. This means thatyou
can define the angle of this plane relative to the
horizontal.

Define a horizontal plane using the cursor and set
it by clicking the mouse button, set X:6.00, Z:0.00
(Fig. 62).

Fig. 62

SET CUT PLANES

u.

VIEW:Front X: 8,00 DX: 0.00 tt FRONT: 0.00 DIST,: 0,00 FREE:100Z M
T00L:Line Z: 3,00 DZ: 0.00 « BACK : 0,00 ANGLE: 0,00 Z00M:100 T
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Chapter 2: Tutorial

VIEW:Front
T00L:Line

Set the cursor in position X:8.00/Z:3.00 and click
the mouse button to set the first point of the second
plane; then move it to X:3.00/Z:6.00 and click
again tocomplete theoperation. Youhave defined
ahorizontalplane thatpasses throughthe assigned
coordinates.

Fig. 63

3,00
6.00

DX

DZ

SET CUT PLANES

5.00
3,05

tt FRONT

» BACK

0.00

0,80

DIST,:
ANGLE:

5,86
31,38

FREE:i00/ M
ZOOM:100 T
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Once theplanes aredefined, Master CAD shows youthe
PlanesMode window. PressO^tousetheCufMode (Fig.
64). You nowhave afirstplaneatZ=0 anda second plane
of variable height.

Fig. 64

'""-•

VIEW:Front X: 3,00
TOOLlLine Z: 6,88

SET CUT PLANES
\—\

Planes Mode Selection

m l^nillH

m 1 HI-CONTAIN 1

m 1LOW-CONTAIN 1 -,

. . s.

OK |
V. .

DX: 5.08
DZ: 3.05

tt FRONT: 0,00 DIST,: 5.86 FREE: 108'/ M
» BACK : 0,00 ANGLE; 31.38 ZOOM: 100 T
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Open theControl menu andselectSPIN STEP (Fig. 65).
Observe the dialog box (Fig. 66) that permits you to
choose a regular polygon, from a triangle to a 99-sided
polygon.

Fig. 65

Desk File ItffrHTIl View Planes Tools Mode Select Process 3-D
Zoon

Grid

Units

Origin
Reverse Screen
Screen Center

.

Ru er s on/ if
™!

VIEWiPlan

T00L:Line

-1,05

-5,10

DX: 0,00

DY: 0,00

tt UP

^ DOWN

8,47
0,00

DIST.:

ANGLE:

0,00

0,00

FREE:100* M
ZOOM:100 T

Choose the Hexagon option and press OK to confirm.
Open the Tools menu and select Regular Polygon (Fig.
67). Place the cursor in the middle of the screen and click
the mouse button to fix the center of the polygon.
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Fig. 66

s£\ Revolution Step
\X Selection

1STANDARD - 18 ELEMEHTS~|

1 TRIANGLE I •IIWHillB

RECTANGLE I |HEPTAGON I

PENTAGON OCTAGON 1

ICANCEL I

VIEW:Plan X:-1.05 DX: 0,00 » UP : 8,47 DIST,: 0,00 FREE:100Z M
TOOLlLine Yl-5,10 DY: 0,00 tt DOWN : 0,00 ANGLE: 0,00 ZOOM:100 T

Fig. 67

Desk File Control View Planes jfTIPl Mode Select Process 3-0

VIEW

TOOL

Plan

Line

X: 0,60

Y: 5.25

DX: 0.00

DY: 0,00

Line

Rectanqle
Regular Poluaon(cirde)

Polyline
Polygon
Clockwise Arc

Counterclockwise Arc

Text

tt UP 1 7,46 DIST,: 0.00 FREE: 100'/. M
tt DOWN : 0.00 ANGLE: 0.00 ZOOM:100 T
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Chapter 2: Tutorial

If there is already another preset object on the screen, set
thecenterof thepolygonto one side so that the objectsdo
not collide. Move the mouse and notice the polygon
forming around the center point.

Fig. 68 Using the cursor,
draw the Polygon outline

VIEW:Plan
T00L:Circ.

3.50
1.10

DX: 4,45
DY: 1.50

tt UP

» DOWN

5.70
0.00

DIST.
ANGLE

4.70
18,63

FREEriQQZ M
ZOOM:100 T

Choose the form and size you wish for the polygon, and
click the mouse button to set it. Notice that instead of a
circle, a hexagonal polygon has appeared (Fig. 69).
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Fig. 69

Desk File Control View Planes Tools Mode Select Process 3-D

\

VIEW:Plan X: 5.40 DX: 0,00 tt UP : 4,54 DIST,
TOOLiCirc. Y: 8,50 DY-: 0,08 8 DOWN : 0,00 ANGLE

0.00 FREE1931! M
0.00 ZOOM:100 T

Execute the procedure GENERAL VIEW...

Fig. 70 Viewfrom the Front...

Desk File Control d'ii^ii Planes Tools Mode Select Process 3-D

VIEW:Front X:-5.05 DX: 0,00 » FRONT: 0.00 DIST,: 0,00 FREE:59>: M
TOOLiCirc. Z: 16.35 DZ: 0,00 tt BACK : 0,00 ANGLE: 0,00 Z00M:1Q0 T
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F&. 72 ...r/ie Left

Desk File Control |1JT3t1 Planes Tools Mode Select Process 3-D
Plan

Front

Back

VIEW:Left Y: 4,30 DY: 0.00 « RIGHT: 0.00 DIST,: 0.00 FREE:99* M
TOOLiCirc. Z: 14.05 DZ: 0,00 « LEFT : 0,00 ANGLE: 0,00 ZOOMllOO T

Fig. 72 Now use Filled Planes in 3-D.
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Fig. 73 ...adjust the Vertical andHorizontal View angles

Fig1. 74 View from
anywhere - even inside..
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Procedure : Spin

_

y

Unless you are using this procedure as part of another
process, open the File menu and select theNewoption. If
the Attentionwindow appears, select Continue (Warning:
This will erase anything currently on the Work Screen).

Open the Mode menu and select the SPIN option (Fig.
76). Observe in the dialog box (Fig. 77) that the option
360 SPIN has been selected. Select OK to confirm the

option.

Fig. 75

Desk File Control View Planes Tools Jjpini Select Process 3-D
17 Planes^"

VIEW:Plan
T00L:Line

-1,50
-2,75

OX

DY

0,00
0.00

tt UP
tt DOWN

3,00
0,00

DIST.
ANGLE

0,00
0,00

FREE:100* M
ZOOM:100 T

Spin 69
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VIEW:Plan
TOOLiLine

X:-1.50

Y:-2.75

Fig. 76

Spin Selection

'CD1
^LilmJM

$»- 1Clockwise SPINl

$
ICounterCW SPIN 1

[_

DX: 0,00
DY: 0,00

tt UP
tt DOWN

3,00

0,00
DIST,: 0.00
ANGLE: 0,00

FREE:100* M
ZOOM:100 T

Notice that the message SETREVOLUTIONCENTER BY
CURSOR appears in the upper menu bar and the monitor
shows that you are working in Plan view.

Place the spin center as close to the center of the screen as
possible and click the mouse button to set it (if there is
already another preset object on the screen, set the center
point slightly to one side so that the objects do not collide).
Set a second point with the mouse and notice the effect.
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Chapter 2: Tutorial

VIEW'.Plan
|T00L:Line

1,05
0.95

Fi#. 77 Set Revolution Center

SET REVOLUTIOH CENTER BY CURSOR

DX:
DY:

0.00
o.oa

•-f-

» UP
tt DOWN

3,00
0,00

DIST,:
ANGLE:

0.00

0,00

Fig. 78 Draw A Diagonal

FREE: 100/! M

ZOOM: 100 T|

:

1,70

9,10
DIST,
ANGLE:

3,52
51,34

FREEiiOOZ M

ZOOM:100 T
VIEW:Front X
TOOLiLine Z

DX:

DZi

tt FRONT:
tt BACK :

0,00

0,00

Spin 71
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Fig. 79 Click the mouse to
initiate the Spin

f/l\\ \\\

VIEW:Front X: 15,95 DX: 0,00 « FRONT: 0,00 DIST.: 0.00 FREE:99Z M
T00L:Line Z:-l,35 DZ: 0,00 « BACK : 0,00 ANGLE: 0.00 ZOOM:100 T

Now observe the vertical spin axis, represented by a
broken Une, and the VIEW reading in the monitor that
indicates that you are in the Front view.

72 Chapter 2 — Tutorial

-

rs

r\



Chapter 2: Tutorial

Procedure: Ring

Execute the procedure SPIN (See Above).

Open the Tools menu and select the Polyline option (Fig.
81).

Fig. 80

Desk File Control View Planes PTTlP^ Mode Select Process 3-D

VIEWiFront X:-0.65

T0DL:Line Z: 6,50
DX: 0,00

DZ: 0,00

Line

Rectangle
Regular Polygon(cirde)

Polygon
Clockwise Arc

Counterclockwise Arc

Text

tt FRONT: 0,00 DIST.: 0.88

» BACK : 0,00 ONGLE: 0,00

FREE:100Z M

ZOOM:100 T

Place the cursor to the right of the axis and click the mouse
button to start a line.

Ring 73
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Move the mouse and define any line to the right side of the
axis. Definetwomorelinesin the sameway andthenpress
the space bar (or the right mouse button), to complete the
operation.

Fig. 81 Define a Broken Line and click the right mouse button

i *V

j

i \.
! . \

\

\

1

VIEW:Front X: 0,05 DX: 2,70 tt FRONT: 0.00 DIST,: 2.78 FREEllOflZ M
T00L:Pline Z: 14.75 DZ: 0.65 » BACK : 8.00 ANGLE: 13.54 ZOOMUOB T

Observe how a spun figure is generated starting from the
original lines (Fig. 82)

74 Chapter 2 — Tutorial
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Fig. 82 An object is formed around the selected Center of
Rotation

I. •

•f/ / i i i \ %

I i,1
1 I

-JJ

VIEW:Front X: 15.95 DX: 0,00 « FRONT: 0.00 DIST,: 0.00 FREE:94Z M
T00L:Pline Z:-1.30 DZ: 0.00 tt BACK : 0,00 ANGLE: 0,00 Z00M:100 T

Again Execute the GENERAL VIEW procedure...

Ring 75
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Master CAD

Procedure: Partial Spin

Unless you are using this procedure as part of another
process, openthe File menuandselecttheNewoption. If
theAttention window appears, selectContinue (Warning:
This will erase anythingcurrentlyon the Work Screen).

Open the Mode menu and selectSPIN (Fig. 88).

Fig. 87

Desk File Control View Planes Tools lifTEl Select Process 3-D
W Planes '

VIEWiPlan X: 4,45 DX: 0,00 tt UP : 3,00 DIST.: 0,00 FREE:18flx M
TOOLiLine Y: 7,70 DY: 0,00 tt DOWN : 0,00 ANGLE: 0,00 Z00M:100 T
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Observe in the dialog box that the 360 SPIN option has
been selected (Fig. 89). Now select the CLOCKWISE
SPIN option and click OK to confirm.

Fig. 88

Spin Selection

1 360 SPIN

if*
Hm!JTO!lHJ<!l

$
iCounterCW SPIN 1

OK ^J 1CANCEL I

VIEW:Plan X: 4.45 DX: 0.00 « UP : 3.00 DIST,: 0.00 FREE:100X M
T00L:Line Y: 7,70 DY: 0,00 » DOWN : 0,08 ANGLE: 0.00 Z00M:100 T

Partial Spin 79



Master CAD

Observe the message SET REVOLUTION CENTER BY
CURSOR on the upper menu bar and that the Viewindica
torin themonitorindicates thatyouareinPlanview(Fig.
90).

Fig. 89

SET REVOLUTIOH CENTER BY CURSOR
I

~f-

VIEW:Plan
TOOLiLine

1.05
0.95

DX:
DY:

0,00
0.00

tt UP

8 DOWN
3.00
0,00

DIST,:
ANGLE:

0.00
0.00

FREE: 188* Ml
ZOOM: 100 T|
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Chapter 2: Tutorial

Place the center of spin as close to the center of the screen
as possible and click the mouse button to set it (if there is
already another preset object on the screen, set the center
point slightly to one side so that the objects do not collide),
setatX:0.00,Y:0.00.

VIEW:Plan

T00L:Line
0,00
0,00

Fig. 90

SET REVOLUTION CENTER BY CURSOR

DX: 0.08

DY: 8.88

I

1"

8 UP

tt DOWN
3.00

0.00
DIST.:
ANGLE:

0.00

0,00
FREE:10QZ M
ZOOMilOO T
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Observe the rotation indicator that pivots around the
center of spin and the message SETINITIAL ANGULAR
POSITION.

Fig. 91

SET INITIAL ANGULAR POSITION

VIEW:Plan X: 2.80 DX: 2.75 8 UP : 3.00 DIST,: 2.75 FREE:100Z M
T00L:Line Y: 0,05 DY: 0,00 tt DOWN : 0.00 ANGLE: 0,00 ZD0M:100 Tl
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Chapter 2: Tutorial

Move the indicator to the right until the Angle readout is
at 0.00 in the monitor degrees and click the mouse button
to set the initial position of spin. Observe the message SET
FINAL ANGULAR POSITION.

VIEW:Plan X:
T00L:Line Y:

•0,25
•0,50

Fig. 92

"SET FINAL ANGULAR POSITION"

Angle Selection

090J
|

1 GRAPHIC MODE |

I OK J CANCEL I

DX: 1,50
DY: 0,00

8 UP
8 DOWN

3,00

0,00

DIST,!

ANGLE:
1.50

0.00
FREEUOOZ M
ZOOM:100 T

When the Angular Selection dialog box pops up, press
Escape. The angle indicator will present a blank. Type in
90.00 degrees (one quarter turn) and click the mouse
button on OK to set the final position of spin.

Observe now the vertical spin axis, represented by a
broken line and the Viewdisplay indicating that you are in
Front view.

Open the Tools menu and select Clockwise Arc (Fig. 94).
Place the cursor on the right side of the axis and click the
mouse button to set the point of origin of the arc.

Partial Spin 83
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Fig. 93

Desk File Control View Planes KTlH Mode Select Process 3-D

VIEW:Front X: 2.05
TOOLlLine Z: 2,85

DX: 0.00

DZ: 0,00

Line

Rectangle
Regular Polygon(circle)

Polyline
Polygon
Clockwise Arc
Counterclockwise Arc T

Text

8 FRONT: 0,00 DIST,: 0.00 FREE:100* M
8 BACK : 0,00 ANGLE: 0.00 ZOOM:100 T
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Chapter 2: Tutorial

Move the cursor to the right and observe the circle that
pivots around the preset point (Fig. 94).

Fig. 94

VIEW:Front X:

TOOLlCC.A. Z:

6.70
5.45

DX: 1.70
DZ: 1.60

8 FRONT:
8 BACK :

0,00
0,00

/

DIST,

ANGLE

2.33

43,26

FREEilOOZ M

ZOOM:100 T
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Place the second point of the circle so that it is entirely on
the right side of the screen and set it by clicking the mouse
button. Press escape, the angle indicator will blank, type
90.00 degrees (one quarter turn) and click the mouse
button on OK to set the final position of spin.

Fig. 95 Set at 90° for a quarter spin

SET FINAL ANGULAR POSITION

Angle Selection

CLOCKWISE
:u3u

icoi ere ::ei

GRAPHIC MODE

T'TO 1CANCEL 1

VIEWiPlan
IT00L:Line

X: 2,88
Y: 8,05

DX

DY

2.75
0.00

8 UP

8 DOWN

3.00
0.00

DIST.
ANGLE

2.75
0,00

FREE:108X M
ZOOMUOO T|
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Move the mouse and observe the line that remains at

tached to the end of the arc and the Tool readout that

indicates Polyline. Define any line (if you wish) and then
press the spacebar to complete the operation (Fig. 97).

Fig. 96

Front X:
Pline Z:

1,20

8,20
DX: 7,30
DZ: 4,25

8 FRONT: 0,00

8 BACK : 0,00

">-.,

DIST.: 8,45
ANGLE: 38,21

FREE:100Z M
ZOOM:100 T

Partial Spin 87



Master CAD

You will see the spun object being generated on the screen.

Fig. 97 Thefinal spun object

-I 1 1 T-l

H •

VIEW:Front X:-5,25 DX: 0,00 8 FRONT: 0.00 DIST.: 0.00 FREE:98X M
T00L:Pline Z: 14,80 DZ: 0,00 « BACK : 0,00 ANGLE: 0,80 ZOOMilOO T

Execute the GENERAL VIEW procedure (See Fig. 98).

Fig. 98

f-\ f

pill
1

\ J; • ..__/
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Procedure : Move Objects

Execute or open the Cylinder exercise if you saved it, or
create a new one using the procedure on page 35. But do
not execute GENERAL VIEW.

Open the Select menu and choose Objects. You will see
the message SELECT OBJECTS AND PRESS RIGHT
BUTTON TO CONTINUE.

Fig. 99

Desk File Control View Planes Tools Mode iflffll Process 3-D

VIEW:Plan

T00L:Line

4,10

9,80

DX:

DY:
0,00

0,00

8 UP

tt DOWN
3,00

0,00

Deselect Points

Deselect Elenents

Deselect Dbjects
Deselect All

DIST,:

ANGLE;

0.00

0.00

FREE:99Z M

ZOOM:100 T

Place the cursor over one of the edges of the object and
click the left mouse button to select it. Click the right
mouse button to return to the drafting board.

Moving Objects 89
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Fig. 100 Select the Cylinder

SELECT OBJECTS AND PRESS RIGHT BUTTON TO CONTINUE
I

I

+

VIEWiPlan X:-2.10
TOOL:Line Y: 3,30

DX: 2.85

DY: 1,90

» UP : 3,00 DIST,: 3.43 FREE:99Z M

tt DOWN : 0,00 ANGLE: 33,69 ZOOM:100 T

90 Chapter 2 — Tutorial
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Open the Process menu, select Move and observe the
message SELECT INITIAL BASEPOINT POSITION
(Fig. 101).

Fig. 101

Desk File Control View Planes Tools Mode Select IJTTnU 3-D

VIEW:Plan X: 3,00

TOOLiLine Y: 3.30
DX: 0,00

DY: 0,00

H-FIip *
V-Flip
Copy
Rotate
Copy Rotate
Proportion

Copy n
C Rotate n

Export
Delete

Show Area

Texture

tt UP : 3.00 DIST.: 0,00 FREE:99Z M

8 DOWN : 0,00 ANGLE: 0,00 ZOOM:100 T

Moving Objects 91
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Now place the cursor over one of the corners of the object
to mark it as a point of reference, click the mouse button
to set it and observe the message SETFINALBASEPOINT
POSITION.

Fig. 102 Select the
Initial Basepoint position

"SET INITIAL BASEPTJINT POSITION

VIEW:Plan X: 0,75 DX: 0,00 8 UP 3.00 DIST,: 0,00 FREE:99Z M

TOOLiLine Y: 1,10 DY: 0,00 8 DOWN 0,00 ANGLE: 0,00 ZOOM:100 T

92

Now move the cursor to any position on the screen and
click the mouse button to set it. Notice how the object
moves to the new position.

Chapter 2 — Tutorial
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Chapter 2: Tutorial

VIEW:Plan
T00L:Line

X: 6.50

Y:-2,80

Fig. 103 Set the
Final Basepoint position..

"SET FINAL BASEPOINT POSITION

DX:

DY:

5.70

3.95

8 UP

8 DOWN

3,00

0,00

DIST,: 6,93
ANGLE: 34,72

Fig. 104 ...and click to move

FREE: 99* M
ZOOM:100 T

VIEW:Plan X: 6,50 DX: 0.00 8 UP 3.00 DIST.: 0.00 FREE:99K M

T00L:Line Y:-2.50 DY: 0.08 8 DOWN 0.00 ANGLE: 0,00 ZOOM:100 1

Moving Objects 93
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Procedure : Flip Elements

Open the HEXAGONAL PRISM created earlier or exe
cute the procedure on page 57, but without executing
GENERAL VIEW.

Open the Select menu and choose POINTS (Fig. 105).
Observe the message SELECTPOINTSANDPRESSTHE
RIGHT MOUSE BUTTON TO CONTINUE.

Fig. 105

Desk File Control View Planes Tools Mode

VIEWlFront X: 18,18
TOOLiCirc. Z: 29.90

DX: o.oo

DZ: 0.00
8 FRONT: 0.00
8 BACK : 8.88

tlenents

Objects
All

Deselect Points
Deselect Elenents
Deselect Objects
Deselect All

Reselect by Elenent

DIST,: 8.80
ANGLE: 8.00

FREE:99Z M

ZOOM 1200 T

Place the cursor over the upper left-hand corner of the
hexagon and click the left mouse to select it. Now trace the
outline boxcompletely around theobject. Click theright
mouse button to confirm.

94 Chapter 2 — Tutorial
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Fig. 106 Place cursor and
click left mouse button...

SELECT POINTS AND PRESS RIGHT BUTTON TO CONTINUE

VIEWlFront X:-12.30 DX: 8.80 8 FRONT: 0.00 DIST.: 9,12 FREE:99'/. M
TOOLiCirc. Z: 16.60 DZ: 2.40 8 BACK : 0.00 ANGLE: 15,26 Z00M:200 T

Fig. 107 Move down and right toform a selection box..

SELECT POINTS AND PRESS RIGHT BUTTON TO CONTINUE

VIEW:Front X: 0,88
TOOLiCirc. Z:-i.lfl

DX: 12.90 8 FRONT: 0,00 DIST.: 21.90
DZ: 17,70 8 BACK i 0,00 ANGLE: 53,91

FREE:99Z M
Z00M:200 T

Flip Elements 95
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Open the Process menu and select H-Flip (Horizontal
Flip) (Fig. 108). Observe the axis on the screen. Move it
until it touches the extreme right point of the hexagon and
click the mouse button to define it.

Fig. 108

Desk File Control View Planes Tools Mode Select tUTTtm 3-D

VIEW:Front

ITOOLiCirc.
X: 3.40

Z: 0.00
DX:

DZ:

0.00

0,00

8 FRONT:
8 BACK :
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8,80

0,00

DIST,:

ANGLE:

Group
Move

V-FIip ^
Copy
Rotate

Copy Rotate
Proportion

Copy n
C Rotate n

Export
Delete

Show Area
Texture

0,00
0,00

FREE:99* M
ZOOM:200 T
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VIEW:Front

TOOLiCirc,

X:-1.80
Z: 16.30

Fig. 109 Move the axis to the
Hexagon and click

SET FLIPPING AXIS

I

DX: 0.00

DZ: 0.00

8 FRONT:

8 BACK ;

0.00

0.00

DIST.

ANGLE

0.00 FREE:99* M
0,00 Z00M:20Q T

Flip Elements 97
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Observe the new position and orientation of the element
(Fig. 110).

Fig. 110

VIEW:Front
TOOLiCirc,

Xl-1,90
Z: 16.60

DX: 0,00
dz: o.oo

8 FRONT: 0.00
tt BACK : 0,00

0IST.:
ANGLE:

0,00
0,80

FREE:99* M
ZOOM:200 T

98

Open the Process menu again and select V-FLIP (Ver
tical Flip) (Fig. Ill), and observe the axis on the screen
(Fig. 112). Move it until it touches the extreme top point
ofthe hexagon and click the mouse button to define it (Fig.
113).
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Fig. Ill

Desk File Control View Planes Tools Mode Select I'JJ.M-l-tl 3-D

VIEW:Front X:-2.00

TOOLiCirc. Zl 16,60

VIEWiFront

TOOLiCirc,

X: 13,00

Z: 13.80

DX: 0,00

DZ: 0.80

tt FRONT: 0,00

tt BACK : 0,00

Fig. 112

SET FLIPPING AXIS

DX:

DZ:

0,00

0,00

8 FRONT: 0,00

8 BACK : 0,00

DIST,: 0,00

ANGLE: 0,00

DIST,: 0,00

ANGLE: 0,00

FREE:99Z M

ZOOM:200 T

FREE:99/ M

ZOOM: 200 T

Flip Elements 99
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Fig. 113

VIEW:Front X: 13,00 DX: 0,00 8 FRONT: 0,00 DIST.: 0.08 FREE:99Z M
TOOLiCirc. Z: 13,50 DZ: 8,00 tt BACK : 0.00 ANGLE: 0.08 Z00M:2OO T|

Execute the GENERAL VIEW procedure if you wish.
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Procedure : Copy

u

_

-

_

_

-

Open the CYLINDER.OBJ created earlier, or execute the
procedure described on page 35. Do not execute GEN
ERAL VIEW.

Open the Select menu and choose Points (Fig. 114).
Observe the message SELECT POINTS AND PRESS
RIGHT BUTTON TO CONTINUE.

Desk File Control View Planes Tools Mode

VIEWiPlan

T00L:Line
-12,60

9,70
DX

DY

0,00

0,00

8 UP

8 DOWN

3,00

0,00

Select IU>M.4&V -D

Points
Elenents *
Objects
All

Deselect Points

Deselect Elenents
Deselect Objects
Deselect All

DIST.:
ANGLE:

0.00

0.00

FREE:99Z M

ZOOM:108 T

To select the points to copy, it is necessary to define a
rectangular area that will contain them. To do this, place
the cursor at some point on the upper left-hand part of the
screen, above the circle, and click the mouse button to
initialize the area.

Move the mouse to the right, and notice the rectangle
drawn with broken lines that appears attached to the preset
point and to the cursor. Define a rectangular area that

Copy 101
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contains the entire circle and click the mouse button to
select it. Observe the selection indicators that are now part
of the circle. (If for some reason some point is not
indicated, repeat the previous procedure until all points
are selected.)

Fig. 115

SELEW PU1NIS AND PRtSS RIGHT IBUTTON TO CONTINUE

_J ..... . ...

VIEW:Plan
TOOLiLine

X: 2.25
Yi-0.15

DX: 8.30
DY: 6.25

8 UP

8 DOWN
3.00
0,00

DIST.: 10,39
ANGLE: 36.98

FREE:99Z M
ZOOM:100 T

Press the right mouse button to complete the process of
selection. Open the Process menu and select Copy (Fig.
116). Observe the message SET INITIALBASEPOINT
POSITION. Place the cursor in the center of the circle and

click the mouse button to mark it as a point of reference.
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Fig. 116 Select Copy

Desk File Control View Planes Tools Mode Select UJiMiil 3-D

VIEWlPlan X: 2.95
TOOLlLine Y: 0,20

VIEW:Plan X: 0,75
TOOLlLine Yi 1.10

DX: 0.00

DY: 0,00

Group
Move

H-Flip
V-Fli

Rotate

Copy Rotate
Proportion

Copy n
C Rotate n

Export
Delete

Show Area

Texture

tt UP : 3,00 DIST.: 0,00
8 DOWN : 0,00 ANGLE: 0.00

Fig. 117 Set the Initial Basepoint

"SET INITIAL BASEPiOINT POSITION-

FREE:99* M
ZOOM:100 T

DXi 0.80

DY: 0,00

tt UP ; 3,00 DIST,: 0,00 FREE:99Z

tt DOWN : 0,00 ANGLE: 0,00 ZOOM:100

Copy 103
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Observe the message SET FINAL BASEPOINT POSI
TION. Move the cursor to any point outside the circle and
click the mouse button to define it as the center of the new

circle.

Fig. 118 Set Final Basepoint and click...

SET FINAL BASEPDINT POSITION

VIEW:Plan
TOOLlLine

X: 8,45
Y:-3,35

DX:

DY:

9.90

4.45

8 UP
8 DOWN

104 Chapter 2 — Tutorial

3,00

0,00

DIST.: 18,85
ANGLE: 24,20

FREE:99Z M
ZOOM:100 T
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VIEW:Plan
TOOLlLine

X: 8.45
Y:-3,25

DX:

DY:

Fig. 119 Copy ofobject
appears at set point

8.80

8,00

8 UP

8 DOWN

3.00
0,08

DIST,

ANGLE:

0,00

00

FREE:98/ M
ZOOM:100 T

GENERAL VIEW may be executed at this point if
desired (See Figures 120-125).
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Chapter 2: Tutorial

Procedure : Rotate Elements

Open the CUBE.OBJ created earlier or execute the CUBE
procedure without executing GENERAL VIEW.

Open the Select menu and choose Points (Fig. 126).
Observe the message SELECT POINTS AND PRESS
RIGHT BUTTON TO CONTINUE.

Fig. 126

Desk File Control View Planes Tools Mode

VIEW:Plan

TOOLlLine

X: 8,95

Y: 9,98

DX:

DY:

0,00

0,00

8 UP

8 DOWN

3,00

0,00

Elenents *
Objects
All

Deselect Points
Deselect Elenents
Deselect Objects
Deselect All

DIST.:

ANGLE:

0.00

0,00

FREE:99Z M

ZOOM:100 T

To select the points to rotate, it is necessary to define a
rectangular area that will contain them. To do this, place
the cursor at some point on the upper left-hand part of the
screen, above the cube, and click the mouse button to
initialize the area.

Move the mouse to the right, and notice the rectangle
drawn with broken lines that appears attached to the preset
point and to the cursor. Define a rectangular area that

Rotate Elements 109
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contains the entire cube and click the mouse button to

selectit. Observethe selectionindicatorsthat arenowpart
of the cube (if for some reason some point is not indicated,
repeat theprevious procedure until allpoints are selected).

Fig. 127 Use the rectangle to
select the cube

VIEW .'Plan
TOOLlLine

SELECT POINTS AND PRESS RIGHT BUTTON TO CONTINUE

4.25

•3,15

DX:

DY:
8.95
6,40

8 UP

8 DOWN
3.00
0.00

DIST,:

ANGLE:
11.00
35,57

FREE:99X M

ZOOM:100 T

Press the right mouse button to finalize the process of
selection.

Open the Process menu, select Rotate (Fig. 128), and
observe the message SET SPIN CENTER (Fig. 129).
Place the cursor over one of the sides of the chosen

element and click the mouse button to set the center of

rotation.
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Fig. 128

Desk File Control View Planes Tools Mode Select IJJ.HJil 3-D
Group
Move
H-Flip
V-Flip
Copu
Jllfll— \H
Copy Rotate
Proportion

Copy n
C Rotate n

Export
Delete

Show Area
Texture

VIEW:Plan X: 4.20 DX: 0.00 8 UP : 3.00 DIST,: 0.00 FREE:99Z M
TOOLlLine Yl-2.75 DY: 8.88 8 DOWN : 0,00 ANGLE: 0.00 Z00M:100 T

Fig. 129

SET SPIN CENTER

L

* .

VIEW:Plan X: 1,85 DX: 0.00 8 UP 3.00 DIST.: 0.08 FREE:99* M

TOOLiLine Y: 3,05 DY: 0.00 8 DOWN 0,00 ANGLE: 0,00 ZOOM:100 T

Rotate Elements 111
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The AngleSelection dialog box will appear. Press escape
to clear the three O's from the degree indicator and insert
30, with clockwise selected. Press the OK button.

Fig. 130 Set Angle at 30

"SET INTIAL ANGULAR POSITION

Angle Selection

:3oL
CLOCKWISE

COUNTERCLOCKWISE |

GRAPHIC MODE I

IkTI I CANCEL I

VIEWiPlan X: 1.05 DX: 8,80 8 UP i 3,88 DIST,! 8.80 FREE:99X M
TOOLiLine Y: 3,05 DY: 0,00 8 DOWN : 0,00 ANGLE: 8.80 Z80M:100 T

The object (cube) has now rotated 30° to the right of its
original position.
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VIEW:Plan
TOOLiLine

FREE:99* M
ZOOM:100 T_

Rotate Elements 113
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Procedure : Proportion

Execute the CYLINDER procedure from page 35, or
open the one executed previously. Do not execute
GENERAL VIEW.

Open the Select menu and choose OBJECTS (Fig. 132).
Observe the message SELECT OBJECTS AND PRESS
RIGHT BUTTON TO CONTINUE.

Fig. 132
Desk File Control View Planes Tools Mode tiWl| Process 3-D

Points

Elenents

All *

Deselect Points
Deselect Elenents

Deselect Objects
Deselect All

VIEW:Front Xi-S.ZO DX: 0.00 8 FRONT: 0.00 DIST,: 8,80 FREE:99X M
TOOLlLine Z: 14,90 DZ: 0,00 8 BACK : 0.00 ANGLE: 8,88 Z00M:18B T
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Place the cursor over any point on the perimeter of the
polygon and click the mouse button to select it. Observe
the message SELECT OBJECTS AND PRESS RIGHT
BUTTON TO CONTINUE. Move the cursor to the side of

the cylinder and press the right mouse button to select (Fig.
133).

VIEW:Front
TOOLlLine

Fig. 133

"SELECT OBJECTS AND PRESSl RIGHT BUTTON TO CONTINUE"

0.35
8.75

DX: 15,65

DZ: 8,25
8 FRONT:

8 BACK :

8,00

8.00
DIST,:
ANGLE:

17.69

27.80
FREE:99* M
ZOOM:100 T

Open the Process menu and select Proportion. Observe
the message SET PROPORTION CENTER.

Proportion 115
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Fig. 134 Select Proportion
from the PROCESS Menu

Group
Move
H-Flip
V-Flip
Copy
Rotate

Copy Rotate
IJ/pMiUTTil] • •

-_ _-

} Copy n
C Rotate n

Export
Delete

•*? — — J-"'

Show Area
Texture

VIEW:Front

TOOLlLine

5,10

8,95

DX: 0,00

DZ: 0,00

8 FRONT:

8 BACK

8.80

0,00

DIST,: 0,00

ANGLE: 0.00

FREE:99J! M

ZOOM:100 T

VIEW:Front X:
TOOL.'Line Z:

•2,05
8,50

Fig. 135 Place the cursor
at the Center...

SET PROPORTION CENTER

I

DX: 0.00
DZ: 0.00

8 FRONT:
8 BACK :

0.08
0,08

DIST.:
ANGLE:

8.80

0,00

116 Chapter 2 — Tutorial
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Chapter 2: Tutorial

Place the cursor in the center of the polygon and click the
mouse button to define it. Notice the message SET
INITIAL PROPORTION.

VIEW:Front X:
TOOLlLine Z:

2.05
8.45

DX:

DZ:

Fig. 136 ...and set
the INITIAL PROPORTION

SET INITIAL PROPORTION

0.00

0.80

8 FRONT: 0.00
8 BACK : 0,08

DIST.:

ANGLE:

0.00

0,00

FREE: 99'/ M

Z00M:100 T

Move the cursor and observe the rectangle drawn with
broken lines that grows from the fixed point.

Proportion 117
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Define a rectangle that contains the selected figure and
click the mousebuttonto confirm. Observe the message
SET FINAL PROPORTION.

Fig. 137 Click the left mousebutton afterenclosing the object

SET INITIAL PROPORTION

VIEW:Front

TOOLlLine
X: 0,85

Z: 7.10

DX:

DZ:

0,00

0,00

'-, I'

8 FRONT: 0,00
8 BACK : 0,00

118 Chapter 2 — Tutorial

DIST,:
ANGLE:

,00 FREEI99Z M

ZOOM!100 T
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Chapter 2: Tutorial

Move the cursor again and observe the broken-line rec
tangle that represents the new proportion (Fig. 138).

Fig. 138

SET FINAL PROPORTION

i- . i

1-r r;

i i . . . .
'

VIEW:Front X: 7,25
TDQLlLine Z: 3,65

DX: 0.00
DZ: 0.00

FREE:99K M
ZOOM:180 T

8 FRONT: 0.00
8 BACK : 0.00

DIST,: 0.00
ANGLE: 0.00

Proportion 119
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Now define a rectangle larger than the first and click the
mouse button to confirm (Fig. 139).

Fig. 139

VIEW:Front X: 7,20 DX: 0.00 8 FRONT: 0.00 DIST.: 0.00 FREE:99X M
TOOLlLine Z: 3.75 DZ: 0.00 8 BACK : 0,00 ANGLE: 8,00 Z00M:100 T
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Procedure : Copy n Objects

Open the CUBE.OBJ or execute the CUBE procedure
found on page 18.

Open the Select menu and choose Objects (Fig. 140).
Observe the message SELECT OBJECTS AND PRESS
RIGHT BUTTON TO CONTINUE.

Fig. 140

Desk File Control View Planes Tools Mode H4t=Ui Process 3-D

VIEW:Plan X:-4,55

TOOLlLine Y:-0.85

DX: 8.80

DY: 0,00

8 UP

8 DOWN

3,00

0,00

Deselect Points

Deselect Elenents

Deselect Objects
Deselect All

DIST,:

ANGLE:

0.00

0.00

FREE:99Z M

ZOOM:100 T
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Fig. 141 Click the edge
of the cube to select

SELECT OBJECTS AND PRESS RIGHT BUTTON TO CONTINUE

1

VIEWiPlan Xi 0.45 DXi 8,60 8 UP 3,00 DIST,: 2.28 FREE:99Z M

TOOL:Line Y: 0,85 DY: 2,20 8 DOWN 0.00 ANGLE: 74.74 ZOOM:100 T

Place the cursor on one of the edges of the object and clicl
the mouse button to select it. Click the right mouse buttc
to continue.

122 Chapter 2 — Tutorial
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Open the Process menu, select Copy n (Fig. 142) and
observe the message SET INITIAL BASEPOINT
POSITION (Fig. 143).

Fig. 142

Desk File Control View Planes Tools Mode Select ^JAMi-i-l 3-D
Group
Move

H-Flip
V-Flip
Copy
Rotate

Copy Rotate
Proportion

C Rotate n

Export
Delete

Show Area
Texture

VIEW: PI

TOOLlLi
an X: 8,30 DX: 0,00 8 UP : 3,00 DIST,: 8,00 FREE:99Z M
ne Y: 8,35 DY: 0,00 8 DOWN : 0,00 ANGLE: 8,00 ZOOM:100 T

Fig. 143

SET INITIAL BASEPOINT POSITION

i

1
1

1
i ...

i

1
1

,

i

i

... 1 . . .
1

1

VIEWiPlan
TOOLlLine

X:-3.88

Y:-1.90
DX:

DY:

,00

,00

8 UP

8 DOWN

3,00

0,08

DIST,: 0,00

ANGLE:
FREE:99Z M
ZOOM:100 T
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Now place thecursor on the lower left corner of the object
to take it as a point of reference, click the mouse to fix it
and observe the message SETFINALBASEPOINT POSI
TION.

Fig. 144 Set the final
Basepoint position

~

SET FINOL BASEPOINT POSI

i

1

riON
-

\

1 ~

i

m
1
1

,

•

•
1

i

1 />

1
1

-

VIEW:Plan

TOOLlLine
X: 1.00
Y: 2.10

DX: 3,90

DY: 4,05

8 UP : 3,00

8 DOWN : 0,00

DIST,:

ANGLE:

5,62

46,08

FREE:99X

ZOOM:100

M
T

fy

Place the cursor on the upper right corner of the object to
mark it as a destination point ofreference, click the mouse
button to set it and you will see the dialog box Copy n
COMMAND.
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Press the <ESC> key and choose the number ofcopies that
you wish (for the purposes of this tutorial, we recommend
between three and eight copies).

Fig. 145 Enter Number ofCopies (6)

y

-

_

-
LT_ Copy NConand

Nunber:6J__

^ 1 DW J

- 1 OK !CANCEL I

_

VIEW:Plan Xi 1,00 DX: 3,90 8 UP 3,00 DIST,: 5,59 FREE:99Z M
TOOLiLine Y: 2.05 DY: 4,00 8 DOWN 0,00 ANGLE: 45,73 ZOOM:100 1

y

M

-

y

_
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Now select the DW option to define the relative perpen
dicular position between the base and its immediate copy.
Observe the message SETINITIAL BASE POINTand that
the broken line that indicates the heightof the cursor.

Fig. 146 Set theInitial Basepoint

SET INITIAL BASEPOINT

VIEW:Front Xi
TOOLlLine Z:

3,05
0,00

DX:
DZ:

.00

.00
8 FRONT:
8 BACK :
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DIST,: 8,88
ANGLE: 0.00

FREEi99Z M
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Chapter 2: Tutorial

Move the indicator until it touches the base of the object
and click the mouse button to define the initial relative

height. Observe the message SETFINAL BASE POINT.

Fig. 147 Set the Final Basepoint

SET FINAL BASEPOINT

,

. . . . . .

VIEW:Front

TOOLlLine
4.35
4.00

DX:
DZ:

1,15

4,05

8 FRONT:

8 BACK

0.00

0,00

DIST,

ANGLE:
4.21
74.15

FREEi99Z M

ZOOM:100 T

Now place the indicator so that it touches the upper part of
the object and click the mouse button to confirm.

The same dialog box will appear again permitting you to
change the data if you wish. Select OK in this case to
complete the operation.
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VIEW:Plan X: 8,38 DX: 0,00 8 UP : 3,00 DIST.: 0,00 FREE:99Z M
TOOLlLine Y: 8.35 OY: 8,80 8 DOWN : 0,00 ANGLE: 0,00 ZOOMilOO T

Fig. 149...And Observe
the stacked cubes

VIEWiPlan Xi 6,45 DXi 0,00 8 UP i 3.00 DIST,: 0,00 FREE:98!! M
TOOLlLine Y:-4,3Q DY: 0,80 8 DOWN : 0,00 ANGLE: 0,00 Z00M:100 T
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Use the procedure GENERAL VIEW from page 24 to
look at your new creation, then save it if you wish
(Warning: Make sure you save the new drawing under a
different name as you will probably have numerous occa
sions for calling up the CUBE.OBJ file - beginning with
the next procedure).

Desk File Control UUil Planes Tool; Mode Select Process 3-D

Back *
Left

Right

VIEWiFront Xl-5.60 DX: 0,00 8 FRONT: 0,00 DIST,: 0,00 FREE:98!! M
T00L:Line Z: 16,10 DZ: 0,00 8 BACK : 0,00 ANGLE: 0,00 Z00M:100 T

Copy n Objects 129
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Fig. 151

130 Chapter 2 — Tutorial
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Master CAD

Fig. 155

Fig. 156

132 Chapter 2 — Tutorial
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Procedure : Copy Rotate n
Objects

Open the CUBE.OBJ again or execute the procedure
CUBE without executing GENERAL VIEW.

Open the Select menu and choose Objects (Tig. 157).
Observe the message SELECT OBJECTS AND PRESS
RIGHT BUTTON TO CONTINUE.

Fig. 157

Desk File Control View Planes Tools Mode HJIJA1 Process 3-D
Points

Elenents

VIEW:PI an

TOOLiLine

-4,55

-0,85

DX: 0,00

DY: 0.00

8 UP

8 DOWN

3,00

0,00

Deselect Points
Deselect Elenents

Deselect Objects
Deselect All

DIST,:

ANGLE:

0,00

0.88

FREE: 99'/ M

ZOOM:108 T

Copy Rotate n Objects 133
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Place the cursor over oneof the edges of the object and
click the mouse button to select it (Fig. 158). Click the
right button to continue.

VIEWiPlan

TOOL:Line

Fig. 158

"SELECT OBJECTS AND PRESS RilGHT BUTTON TO CONTINUE"

X: 0.45
Y: 8.85

DX: 0,60

DY: 2.20
8 UP

8 DOWN
3.00

0,00
DIST,: 2,28
ANGLE: 74,74
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Chapter 2: Tutorial

Open the Process menu, select Ci?c'toten (Tig. 159) and
observe the message SET SPIN CENTER.

Fig. 159

Desk File Control View Planes Tools Mode Select pjii.H+n 3-D

VIEW:Plan
T00L:Line

X: 9.15
Y: 5,85

DX: 0,00
DY: 0,00

8 UP
8 DOWN

3,00
0,00

Group
Move

H-Flip
V-Flip
Copy
Rotate

Copy Rotate
Proportion

Copy n

Export
Delete

Show Area

Texture

DIST.: 0.00
ANGLE: 0,00

FREE:99X M
ZOOM:100 T

Now place the cursor over the lower left corner of the
object to mark it as a point of reference, click the mouse
button to set it. MasterCAD shows you the angle selection
window. Press the Graphic Mode button to continue and
observe the message SET INITIAL ANGULAR POSI
TION.

Copy Rotate n Objects 135
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VIEW;Plan X:-2.95
TOOLlLine Y:-1.85

VIEW:Plan

TOOLlLine
X:-2.95
Yl-1.85

Fig. 160 Set the Spin Center..

SET SPIN CENTER

I

I

DX: 0,00

DY: 0,00
8 UP : 3,00 DIST,: 0.08 FREE:99Z M
8 DOWN : 0,08 ANGLE: 0.08 ZOOM:100 T

Fig. 161 ... Then select Graphic Mode

SET INTIAL ANGULAR POSITION

Angle Selection

rcOUNTERCLOCKWISE]
30-_

GRAPHIC MODE

I OK I

DX: 0.00

DY: 0.08

8 UP

8 DOWN

CANCEL

3.00

0.00
DIST.

ANGLE
0.00 FREE:99Z M
0.00 ZOOM:100 T
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Chapter 2: Tutorial

Move the rotation indicator so that it touches the base of

the object (ANGLE =0) and click the mouse button to set
it. Observe the message SETFINAL ANGULAR POSI
TION.

Fig. 162 Set theInitialAngleat 0.00 degrees (see thereading in
the Monitor)

"SET INTIAL ANGULAR POSITION

VIEWiPlan X: 3,25 DX: 6,25 8 UP 3,00 DIST,: 6,25 FREE:99* M

TOOLlLine Y:-l,75 DY: 0.00 8 DOWN 0,00 ANGLE: 0,00 ZOOM:100 T
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Movetherotationindicator45degrees (ANGLE=45) and
click the mouse button to set it. Carefully observe the
dialog box COPY ROTATIONn.

Fig. 163 Set thefinal angle at 45°

SET FINAL ANGULAR POSITION

VIEWiPlan X: 1.98 DX: 4,90 8 UP : 3,00 DIST,: 6.93 FREE:99J! M
TOOLlLine Y: 3,15 DY: 4,90 8 DOWN : 0,00 ANGLE: 45,00 ZOOM:108 T
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Chapter 2: Tutorial

Press the <ESC> key and choose the number ofcopies that
you wish (for the purposes of this tutorial we recommend
that you choose between four and eight copies).

Fig. 164 Set number at 4 and click DW

EXECUTING SPIN

VIEWiPlan

T00L:Line

1.90
3.15

i

V Copy Rotation N

Nunber:004

1 Mil

r_

DX:
DY;

4,90
4.90

8 UP

8 DOWN

3.00

0,08

DIST.
ANGLE

6.93
45,00

FREE:99H M
ZOOM:100 T

Now select the DW option to define the relative height
between the base object and its immediate copy. Observe
the message SET INITIALBASE POINT and the broken
line that indicates the height of the cursor.

Copy Rotate n Objects 139
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Fig.l65 Setth

INITIAL Bl

e Initial Basepoint

SET ISEPOINT

~

~

^

^

*

'

~

-

v~ r-s

VIEW:I
TOOL:!

"ront X: 4,15
.ine Z: 0,00

DX: 8,00
DZ: 8.88

8 FR0N1
8 BACK

: O.OB DIST,: B.08
: 0,80 ANGLE: 8.80

FREE:99Z M
ZOOM:100 T

r\

Move the indicator until it touches the base of the object
and click the mouse button to define the relative initial

height. Observe the message SET FINALBASE POINT.

Now place the indicator touching the upper part of the
object and click the mouse button to confirm. Observe
again the dialog box that permits you to change the data if
you so wish. In this case, select OK to complete the
operation.
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Fig. 166 Set the Final Basepoint..

SET FINAL BASEPOINT

1

DX: 1,15

DZ: 4.05

8 FRONT: 0,00 DIST,: 4,21 FREE:991! M
8 BACK : 0,00 ANGLE: 74,15 ZOOM:100 T

VIEW:Front X: 4,35
TOOLlLine Z: 4,00

Fig. 167..And Click OK

SET INTIAL ANGULAR POSITION

—i

St Copy Rotation N

1 DW I

[^

VIEW:Plan X:-2.95
TOOLlLine Yi-1.85

DX: 8.00
DY: 0.00

8 UP
8 DOWN

3,00
0,00

DIST,
ANGLE:

,00
0,00

FREE: 99!! M
ZOOM:100 T
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Execute the GENERAL VIEW procedure to see the
results.

Desk File Control irrei piai

mm
Front *
Back

Left

Right

Fig. 168

anes Tools Mode Select Process 3-D

VIEWiPlan Xi-5,55 DXi 0,00 8 UP : 3,00 DIST,: 0,00 FREE:99H M
TOOLlLine Y: 9,90 DY: 0.00 8 DOWN : 8,00 ANGLE: 0,00 Z00MH00 T

Fig. 169
Desk File Control eih-v.m Planes Tools Mode Select Process 3-0

VIEW:Left Y:-15,90 DY: 0.00 8 RIGHT: 0,00 DIST,: 0,00 FREE:99Z M
TOOLiLine Z:-2.95 DZ: 0,08 8 LEFT : 0,00 ANGLE: 0,00 ZOOMilOO T
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Procedure : Mode

Open the Mode menu and select the PLANES option
(Fig. 171). Carefully observe the window PLANES
MODE SELECTION.

Desk File Control View

Fig. 171

Planes Tools

VIEW:PI an

T0OL:Line
1,10

•5,35
DX: 0,00

DY: 0,00

8 UP

8 DOWN

Spin

3,88

8,00

Select Process 3-D

DIST,;
ANGLE:

8,80

8,88

FREE:99Z

ZOOM:100

Up to this point, you have been working in the Cut
mode and have observed that the objects created are
open at the sides. This is because the projection mode
can be presented in several different ways. Taking
CUBE as an example, you will notice that it appears to
be a solid, open at the top and bottom (Cut mode); or
that it appears with a solid base with no top (Cut + Lo-
Contain); or that it appears as a completely solid
object (Cut + Lo-Contain + Hi-Contain).
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Fig. 172 The Planes selection Box
with all options selected

Planes Mode Selection

1—

rffl0 li^l!.^!

•

J—,

0 remBnTTieii

1 OK J | CANCEL I

VIEWiPlan X: 1,10 DX: 0,80 8 UP : 3,00 DIST,: 0,00 FREE:99Z M
TOOLlLine Y:-5,35 DY: 0,00 8 DOWN i 0,00 ANGLE: 0,00 Z00M:100 T
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Now select Hi-Contain and observe that the Cutop
tion remains selected. This is because the mode

functions are cumulative; that is, they can be com
bined. You can now repeat this lesson utilizing the
following modes:

CUT + HI-CONTAIN

CUT + LO-CONTAIN

HI-CONTAIN + LO-CONTAIN

CUT + HI-CONTAIN + LO-CONTAIN

Observe the difference in the objects when presented
as solids.

REMEMBER:

Lo-Contain and Hi-Contain are present when you are
working on Plan view.

Front-Contain and Back-Contain are present when
you are working on Front or Back views.

Left-Contain and Right-Contain are present when
you are working on Left or Right views.
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Master CAD

CONCEPTS

1 hroughout this manual we use several terms
likeprojection, limitplanes, perspective,projectionlines,
points, lines, rectangles, objects, elements, etc.

This section will clear up their meanings (as much as
possible), explain how to identify them, and, above all,
show their interrelationships in the graphic environment
we will call workspace.

Even if you are familiar with the terminology we will use
from now on, it is always a good idea to go through it once
more, further developing the bond between you and the
program.

If you aren't familiar with this subject, read on carefully.
These next few pages will introduce you to the fascinating
world of graphic expression.

PROJECTION

Projection is the graphic representation of an object on a
plane where all the points belonging to the object are
projected.

Professor F. Izquierdo Asensi, in his book Descriptive
Geometry (11th edition, Chapter 1) defines Projection in
the following terms:

The projection ofa point [A] in space (See
Fig. 173) upon a plane [&], from a fixed
point [O], outside the plane, is the intersec
tion [A'] of the projection line [OA] (de-
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fined by [O] and the given point [A]) with
the plane [&]. The fixed point [O] is called
the Projection Center and the plane [&], is
called the Projection Plane.

From the above we can deduce that all points located on
the projection Une [OA], such as [B], will have the same
projection [A'], and that ifthe point is located on the plane
[&] it will merge with its projection, as we can see in [C].
This projection is called Central Conic Projection or
Perspective.

Fig. 173

If the projection center is an "improper" point (meaning
that it is located in infinity), the projection lines will be a
parallel projection.

This brings us to the cylindrical or parallel projection. The
cylindrical projection can be orthogonal or oblique, de-
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pending on whether the common direction of the projec
tion lines is perpendicular or oblique to the projection
plane.

In the first case we have an ORTHOGONAL PROJEC
TION.

Fig. 174

ORTHOGONAL PROJECTION

PARALLEL PROJECTION

The projection lines are parallel and perpendicular to the
projection plane, that we will now call the picture plane.

This type of projection is used to draw plane views, front
and side sections, facades in architecture and engineering,
and to project partial views of every type.
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OBLIQUE PROJECTION

The projection lines are parallel and inclined to the projec
tion plane.

This type of projection is used to draw technical and
mechanical objects and is mainly used in engineering
design. It is very useful because you can measure the
object in 3-D.

PERSPECTIVE

Throughout this manual, when we refer to perspective, we
are referring to a projection system called conical linear
perspective. A practical derivative of the central projec
tion, itself included in the conic system.

We shall then defineperspective as aprojection system by
which an object in space is represented as it would appear
in real life, with a three-dimensional appearance. It will be
projected on a flat surface called the picture plane (see
figure 175).

The effect of this projection can be compared to that of a
photograph taken from any given point.

Applications

A perspective is used by an architect as an important
component of the Architect-Design-Aspect-Customer
relationship, since it affords a faithful rendition of the
shape a building will have when it is finished. The tech
nique is also useful in the fine arts, and in the production
of advertising copy.
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FEATURES

The outstanding difference between perspective and par
allel projection is that the projection lines converge to
wards a common point called the viewpoint.

To achieve an adequate representation of the object, the
projection system must use a series of reference elements
that facilitate the building of images and their location in
the workspace.

The elements that make up the perspective workspace are
the following:

The Master CAD Coordinate System

This is a cartesian coordinate system made up by the three
axes, X, Y and Z, that intersect at a common origin, located
at the center of the screen in the plane X-Y (plan view) and
in the lower center of the screen in the X-Z and Y-Z planes
(front, back and lateral views).

The Viewpoint

This is the point in space from which the represented
object is observed. The coordinate that establishes the
position will be identified as XV, YV and ZV.
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The View Angles

These are the vertical and horizontal angles that defines
the observer's line of sight.

The Picture Plane

This is the vertical surface upon which the object's image
is projected. In this case, your computer's screen will
behave as the picture plane.

The Horizon Plane

This is the horizontal plane that contains the viewpoint.
The intersection between this plane and the picture plane
is the horizon line.
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Fig. 175

VIEWPOINT

^ V

WORKSPACE

r\

H-& = Horizontal view angle V-& = Vertical view angle
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The Ground Plane

This is a horizontal plane (floor), parallel to the horizon
plane. Generally, this is the plane that contains all object
bases and is the default Master CAD lower plane. It can
be defined within the workspace as the set of points with
a common Z coordinate equal to zero. The intersection of
the ground and picture planes is the ground line.

The Vanishing Plane

This is the vertical plane that contains the viewpoint. It
separates the spaces in front of and in back of the observer.
For all practical projection effects, and thus for this
program, you will be able to see only the space ahead of
you; that is, all points that are in front of you and in the
direction you have chosen in the Viewpoint menu.

The Ground Line

As we said before, this is the intersection of the horizon
and picture planes. If the screen is taken as the ground
plane, the ground line can be seen in plan as being in the
picture plane's position.

The Horizon Line

This is the intersection of the horizon and picture planes.
It is separated from the ground line by a distance ZV,
corresponding to the height of the viewpoint. If we take
the screen as the picture plane (see Figure 175, page 154),
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we can see the ground line GL, the horizon line HL, the
height of the viewpoint ZV, the fugue point FP, the
distance points DP, and the distance DV, measured as the
distance between the viewpoint and the picture plane.

The Central Fugue Point

This is the projection PC of the viewpoint on the picture
plane. All lines parallel to the Y axis will converge to this
point.

The Distance Points

These are located to the right and left ofPC and at distance
DV. All lines 45 degrees from the Y axis converge to these
points.

The Limit Planes

These are user-defined planes that limit the projection of
a given object in space. For example, if we have defined
a horizontal plane with an elevation of three meters and a
second horizontal plane at an elevation of seven meters
and we draw (with Master CAD of course!) the plan of a
circle, we will have an object with a height offour meters,
elevated three meters above ground. These planes may be
horizontal, vertical or angled as you wish.

If you are working in a plan view, you may then define
horizontal or inclined limit planes that will determine the
upper and lower limits of the object or objects you wish to
project.
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If you are working in a front or back view, you may then
define horizontal or inclined limit planes that will deter
mine the front and back limits of the object.

If you are working in a left or right view, you may then
define horizontal or inclined limit planes that will deter
mine the left and right limits of the object.

The limit plane is also used to draw graphics contained in
them. In this case, a rectangle drawn on an inclined plane
could represent, for example, the roof of a house; a
cylinder drawn on a plane could be a disc in space, etc.

The Objects

These are sets of lines that make up any figure, and can be
edited as a unit. They can be created in two different ways:

>• from figures included in the Tools menu,

>• combining several of the above using Group
Process.

The Elements

These are straight lines or planes that make up objects.
The former may be separated from the latter using the
Process commands.

The Points

These are singular points that make up elements and can
be selected and processed using the Process commands.
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SPECIAL PROPERTIES OF

THE PERSPECTIVE

PROJECTION

The following are properties that define the Master CAD
Perspective Projection and should be taken into account
when using the program.

>• A system of horizontal straight lines that con
verge at a single point is calleathe Fugue Point of
the system.

>- The horizon lines contain all the Fugue Points.

>- The vertical lines (Z lines), being parallel to the
picture plane, do not appear to converge (if the
view angle is horizontal), and hence will be see as
vertical in perspective.

>- If the vertical view angle is inclined, then the
vertical lineswillconvergeto a singlepoint,called
the Fugue Point of the VerticalSystem.

>* The lines contained in the picture plane will be
actual size, since they will be their own perspec
tive.

>• In the same sense, if a line is located behind the
picture plane, its perspective will be shorter than
the line itself.
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Some Tips

It is important to select an adequate viewpoint, since its
location will determine the results of your perspective. A
badly selected viewpoint can lead to unsatisfying results.

The location of the viewpoint depends on what part of the
object you want to feature. It is a good idea to displace the
object with respect to the viewpoint to avoid views that are
too symmetrical.

When positioning an object with respect to the picture
plane, it is preferable to place it in such a way that its side
faces different angles within the same planes so that
symmetrical views are avoided.

It is common to use angles of 30 or 60 degrees.

The height of the viewpoint above the ground plane is
usually taken as five feet, nine inches (1.8m), that is, the
height of the average person.

However, if the object to be viewed is small, use a height
that is more convenient to you.
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IVl aster CAD is asophisticated ComputerAided
Design system, conceived to let you and your Atari ST
create complete and exact 2-D and 3-D graphics without
having to waste endless hours building data matrices or
fighting with mysterious and primitive user interfaces.

With Master CAD you will always know what you are
doing because you will observe everything with your own
eyes!

If there are any details of MasterCAD that you cannot find
in the manual, do not worry; Master CAD willprovide on
screen help at any time.

Master CAD is made up of two main programs designed
to let you work in two work sections: the DESIGN
SECTION and the OUTPUT SECTION.

The first is conceived to let you design and see your
creation on the screen in an informal draft print; the second
lets you obtain quality hard copy of your work on printers
or plotters.

It is important to understand the capability of the drafting
board. TheAtari ST has three different screen resolutions:

640x400 monochrome, 640x200 RGB color, and
320x200 RGB color (Master CAD does not run in the low-

resolution, 320x200 mode).
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Master CAD uses the screen as a "window" into a larger
workspace. The Master CAD workspace is a cartesian
space with more than 4,000 kilometers in each positive or
negative axis direction (that's about 2,500 miles!).

As you progress within Master CAD, you will create very
sophisticated graphics more quickly each time. We
strongly recommend that you save your work often to
avoid disaster should your dog decides to munch unex
pectedly on your power cord!
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DESIGN

SECTION

2-D MAIN MENU

FILE

Menu to select file-handling operations.

File
Fig. 176

Hew
Open
Append
Import
Save
Save as

Draft Print
Save Screen

Quit

NEW

The NEW command allows you to reset all parameters
and default conditions. It also allows you to create a new
workfile from scratch.
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If you select the New file option and there is any workfile
present in memory, you will see the following dialog box
(w8).

Fig. 177

VIEW: Plan

T00L:Line
X:-13,65

Y:-2.60

U0RNIH6!

This Operation Mill REMOVE

YOUR CURRENT WORK FROM MEMORY

CONTINUE CANCEL

DX: 0.00

DY: 0.00
tt UP
tt DOWN

3.00

0.00

DIST,: 0,00

ANGLE: 0,00

FREE:S9X

ZOOM:100 V,

You must decide what to do with the current file in

memory.

If you CONTINUE the operation, you will lose all this
information, so please be very careful when using this
command.

If you decide to SAVE your work, Master CAD will go
directly to the SAVE dialog box. The SAVE command
will be discussed later.

Ifyou CANCEL the operation the system will return to the
drafting board, as if nothing had happened.
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OPEN

Thiscommand opens apreviously saved [.OBJ] workfile.
It resets all work parameters and default conditions and
erases any information contained in memory.

If you select this option while you still have a workfile in
memory, you will see the same dialog box that you saw
with the NEW command, soplease becareful using this
command.

Anyfileyouopenhas tohavebeensavedbyMasterCAD.
After selectingthe OPENoption,you will see a list of files
whichhave the fileextender[.OBJ]. Youcan open a file
by typing the filename or by double clicking on the
filename from the file directory.

APPEND

This command opens a previously saved [.OBJ] workfile
and attachs it to the current file in memory. It doesn' t reset
the current parameters.

This option lets youmerge twofiles together to create one
larger file. When you append the second file to the first
file, you want to make sure the combined size of both files
doesn't exceed the memorylimitationof your computer.

Check the amount of memory available and the size of the
two files before beginning this operation, as Master CAD
will only acceptinto thecomputer's memorythatportion
of the file that fits. The remainder will not load.

If youwish toAppend afile, it has tohavebeensavedusing
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Master CAD. After selecting the Appendoption, you will
see a list of files which have the file extender [.OBJ].

You can append a file by typing the filename or by double
clicking on the filename from the file directory.

Once the append operation is completed the appended file
will appear selected, so you can place it wherever you

want using the Move command of the Process menu.

IMPORT

This is a command to import objects from another file.

The objects being exported from the source file are saved
in a buffer file named CONTAINER.OBJ that you can
open if you want. If you wish to import the contents of the
buffer file, it is necessary that the objects in that file were
stored using Master CAD.

Check first for the amount of available memory before
using this command; Master CAD will accept only that
part of the new file that fits in available memory.

To import the buffer file, open the File menu and select
Import.

Once the import operation is completed, the contents of
the buffer file will appear selected so you can place it
where you want by using the Move command of the
Process menu.

NOTE: If you attempt to import an empty Buffer file
(before using the Export command) you will get a TOS
error.
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SAVE

This command saves to disk the object created as a
FILENAME.OBJ.

If the file has been previously saved with a user-defined
filename, this command will preserve that filename.

SAVE AS

Command to save to disk the file created with a user-

defined filename.

When this option is selected, you will see the normal Item
Selector with a list of files having the filename extender
.OBJ.

If you are saving a file for the first time, you will have to
enter a new filename. Be sure that the filename has the

.OBJ extender; otherwise, the file will not be displayed the
next time you select Open. When satisfied with the
filename, select OK and the file will be saved.

DRAFT

This command sends a screen dump to the printer.

This option prints the picture in the current screen on your
printer. You must have installed your printer driver
properly (see the INSTALL PRINTER accessory on the
desk menu).

If you press ALT+HELP during a draft print operation, the
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printout will be canceled and the system will return to the
workscreen. Please wait for the cursor and the monitor to

appear before continuing to work.

SAVE SCREEN

This command saves the screen contents to different

formats for quality print or plotting purposes. You can
select two formats for saving the screen:

DEGAS format: The picture files saved with this format
can be used by DEGAS" and other DEGAS compatible
programs. The .i.DEGAS"; file is uncompressed and
saved with the .PI3 extender for monochrome and .PI2 for

RGB color.

MASTER CAD PRINTFILE: This is a special Master
CAD file used by the OUTPUT section. If you want to
print or plot your work, you need to save it in this format.
These files are saved with a .PRF extender.

You have to define the zoom value in your printfile. This
value defines the exact scale for plotting purposes. De
pending on your printer, the ZOOM 1:89 may be printed
in 1:100 scale; therefore, it is important to know the aspect
ratio between the program and your printer. This must be
tested and defined by the user.

When either of these options are selected, you will see the
normal Item Selector with a list of files having the corre
sponding filename extender. If you are saving a new file
for the first time, you will have to enter a new filename.
When you are satisfied with the filename selected, select
OK and that file will be saved.
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QUIT

Command to quit the DESIGN section and return to the
Desktop.
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CONTROL

Menu to define the work conditions and parameters.

Fig. 178

Control
Zoon
Grid
Units
Origin
Reverse Screen
Screen Center
Spin Step
Rulers on/off
Keyboard Input

ZOOM

Command to modify the zoom. Therange is from 1:1 to
1:1000.

We have named this command Zoom instead of Scale
because we cannot guarantee the exact scale, given the
endless list ofprinters on the market! You can be sure that
the current zoom will give accurate plots on plotters
supported byMasterCAD. Inthecaseofprinters, youcan
adjust thezoom until you obtain thedesired scale onyour
printouts.
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To modify the zoom, open the Control menu and select the
Zoom option. You will see a dialog box having different
common zoom choices. Select the option you want and
press OK to confirm.

If you want to define the zoom by input, press the Zoom
option to activate it, enter the desired zoom number (from
1 to 1000), then press OK to confirm. If you enter a
number greater than 1000, Master CAD will ignore it.

Fig. 179 ZOOM Select Box

Once the selection is made, you will see the objects on the
screen in a new size (if the zoom selected is larger than
before), or the new smaller screen that you can place by
cursor movement (if you selected a smaller zoom than
before).
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You will see the message SET THE SCREEN CENTER
BY CURSOR. Press the left mouse button to define the

center.

Fig. 180 Set Screen

SET NEW SCREEN CENTER

VIEWiPlan X:
_T00L:Line Y:

0,50

10,60

GRID

DX:
DY:

0.00
0.00

tt UP
_n DOWN

3.00
0.00

DIST,: 0,00
.ANGLE: 0.08

FREE
_Z00H

:35X Ml
200 Tj

A grid of dots can be displayed on the screen for your
reference. You will have three ways of using the grid:

GRID ON/OFF: Toggles the grid on and off.

SNAP ON/OFF: Toggles the snap function. The snap to
grid function causes a user-defined point to be automati
cally aligned to the nearest grid point. This allows for
greater accuracy in your graphics work. Once selected,
the snap function is activated by pressing the SHIFT key
while, drawing.
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SET GRID: Sets the size of the grid. Select SET GRID
from the dialog box, and you will see the message SET
GRID and a square at the lower left corner of the screen.

Fig. 181 Grid Dialog Box

:::;::: 5r

GRID ON/OFF I SNAP ON/OFF!

OiT>n 1 CANCEL |!

Move the cursor inside and to the lower left comer of this

square. You can modify the grid display through cursor
movement. You can also observe the grid size readings
DX and DY or DZ to help you obtain greater accuracy.
Once the grid has been defined, press the mouse button to
verify your choice. The system will return automatically
to the drafting board.
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Fig. 182 Size Box

SET GRID

-••: --"-

mrM-M.'^lM SNAP ON/OFF !

wmmm] set grid |

i\ OK ti i CANCEL |

"'

an Xi-15.50 DX: 0.20
e Yi-1.40 DY: 0.40

I UIEU:Pla
LTOOLiLin

UNITS

» UP : 3,00 DIST.: 0,45 FREE:99Z M
J* DOWN : 0,00 _ANGLE: 63.43 _Z00M:100 B

This command lets your select the units of measurement
you will use for objects displayed on the screen.
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Fig. 183 Unit Selection

Units Selection

CANCEL I

You have the following options: meters, centimeters,
millimeters and inches. Select the option you prefer and
OK to confirm your choice.

ORIGIN

Command to set a user-defined coordinate origin point.
To define the new origin open the Control menu and
select Origin. You will see the message SET NEW
ORIGIN. Place the cursor where you wish the new origin
to be and click the mouse button to confirm it.
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UIEWiPlan
LT00L:Line

•2.10
•2,85

DX:
DY:

Fig. 184

SET NEW ORIGIN

0.00
0,00

» UP
_8 DOWN

3,00
0,00

REVERSE

DIST,:
.ANGLE:

0,00

0,00
FREE:99

.ZOOM:180
V. M]
o tJ

This command reverses the screen and its contents from

white to black and vice versa (i.e., reverse video). Open
the Control menu and select Reverse Screen. The screen
will change instantly.

SCREEN CENTER

This command lets you move the window (screen) over
the entire workspace. Open the Control menu and select
Screen Center. You will see the message SET NEW
SCREEN CENTER.
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m
Move the cursor, and you will see a rectangle drawn with
broken lines that represents the boundaries of the new
screen. Place the screen center (the cursor) where you
want and click the mouse button to define it.

SPIN STEP
r
•Command to select the regular polygon step number. This

means the number of sides of a regular polygon. This
value is used by the Regular Polygon tool and by the Spin
object generation mode.

Open the Control menu and select Spin Step. You will
see a dialog box that lets you select any of the more
common regular polygons. Select the option you want and
press OK to confirm. ^

You will observe that the default value for a circle is 18 —

sides, but you can modify this as you wish. ^

~
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Fig. 185 Spin Step Dialog Box

Ifyou want todefine theSpin Step byinput, selectNumber
to activate it. Enter the desired spin step number (from 3
to 99) and press OK to confirm. If you enter a number
greater than 99, Master CAD will ignore it.

RULER ON/OFF

This command toggles the graphic rulers. When the ruler
is on, you can visually align figures by the markings on the
ruler. You will also be able to adjust the spacing on the
ruler by setting the grid (see SET GRID page 173). The
ruler spacing will automatically match the grid spacing.
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INPUT

This command selects the input mode. Open the control
menu and select the input option, observe the dialog box
indicating that you may choose between the graphic mode
(default) and the keyboard mode. In the keyboard mode

coordinates are entered directly from the keyboard.

COLOR

This command selects the color to be used.
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VIEW

Menu that selects the orthogonalview you will work with.

Fig. 186 View Menu
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PLANES

Menu to determine the type of projection planes you will
work with.

Fig. 187

Planes

Nornal

Front Angled
Side Angled
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NORMAL

Command to define projection planes that are parallel to
the view plane that you are working with.

For example, when you define normal planes while work
ing on the Plan view, these planes will be horizontal and
obviously parallel to the floor.

Ifyou define it while working on Front view, these planes
will be vertical and parallel to the front projection plane.

To do this, open the Planes menu and select Normal.
You will see the message SETCUTPLANESand a broken
Une that indicates the plane's level.

Move it until you are satisfied with the position of the
plane, and then click the mouse button to confirm it.
Repeat to position a second plane.

Note that if you are in Plan view, you are always going to
define the normal planes in Front view because in Plan
view you need only to set the height of the projection
planes.

Ifyou are working in Front,Back, Leftor Rightviews you
are always going to define the normal planes in the Plan
view. That is because these planes will always be vertical.

PLAN ANGLED

Command to define projection planes that are vertical and
inclined in respect to the view plane you are working with.
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You can only define PlanAngled planes if you are work
ing in Front, Back,Leftor Rightviews.

To place them, open the Planes menu and select Plan
Angled. You will see the message SETCUTPLANES and
a broken line indicating the plane's position. Observe that
you are in Plan view.

ThePlanAngled planes have to be definedby settingtwo
points of the line that represents the plan on the screen.
These points also determine the angle between the cut
plane and the view projection plane.

Repeat this operation for the second plane and Master
CAD will automatically return to the view you are work
ing on.

Fig. 188

PLAN ANGLED PLANES
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FRONT ANGLED

Command to define projection planes that are inclined in
respect to the horizontal plane.

You can only define Front Angled planes if you are
working in Plan, Left or Right views.

To place them, open the Planes menu and select Front
Angled. You will see the message SET CUTPLANES and
a broken line indicating the plane's position. Observe that
you are in Front view.

The FrontAngledplanes have to be defined by setting two
points of the line that represents the plan on the screen.
These points also determine the angle between the cut
plane and the view projection plane.

Repeat this operation for the second plane and Master
CAD will automatically return to the view you are work
ing on.
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Fig. 189

y4
V

FRONT ANGLED planes viewed in PLAN

You can define FrontAngledplanes and use them from the
Right view.

186 Chapter 4 — Commands

-



Chapter 5: Commands

Front Angled planes seen from Right view.

4

Y

SIDE ANGLED

Command to define projection planes that are inclined in
respect to the horizontal plane.

You can only define SideAngfed planes ifyou are working
in Plan, Front or Back views.

To place them, open the Planes menu and select Side
Angled. You will see the message SET CUT PLANES and
a broken line indicating the plane's position. Observe that
you are in Left view.

The Side Angled planes have to be defined by setting two
points of the line that represents the plan on the screen.
These points also determine the angle between the cut
plane and the view projection plane.
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Repeat this operation for the second plane and Master
CAD will automatically return to the view you are work
ing on.

M

y
Y

You can define Side Angled planes and use them from
Front view.
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Side Angled planes seen from Front view.

Fig. 192
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SIDE ANGLED planes seen from FRONT view
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TOOLS

ThisMenuselects the graphic toolfor use in drafting.

Fig. 193 Tools Menu

Tools

Line
Rectangle
Regular Polygon(circle)

Polyline
Polygon
Clockwise fire
Counterclockwise Arc

Text
Din

LINE

Command to define a straight line in any direction.

To draw a line, open the Tools menu and select the Line
option. Position the cursor where you want the line to
begin, and click the mouse button to confirm.

Movethemouseandnotethatyouaredrawinga linefrom
thepointyouselected. Ifyoudecide tochange theoriginal
point, press the right mouse button and start over.

To continue, place the cursor at the end point of the line
and click the left mouse button to complete the line.
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RECTANGLE

Command to draw rectangles.

Open the Tools menu and select Rectangle. Position the
cursor where you want one corner of the box to be drawn.
Now click the mouse button and move the mouse. Note

that the rectangle gets larger. If you need to change the
position of the first comer, click the right mouse button
and start over.

Position the cursor where you want the opposite corner of
the rectangle to be and click the left mouse button to
complete the operation.

REGULAR POLYGON

Command to draw circles, ovals and regular polygons.

To draw a regular polygon open the Tools menu and
select Regular Polygon. Position the cursor where you
want the circle center to be and click the mouse button to

set it. Then move the cursor and note an ellipse developing
on the screen.

If you decide to change the center, press the right mouse
button and start over.

Observe the readings DX, DY and DZ indicating the
radiuses of the ellipse. When both radiuses are equal,
press the left mouse button to complete the circle.
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To draw an ovalpolygon, position the cursorwhere you
want the center to be and click the left mouse button to set
it. Move the cursor and note the ovaldeveloping on the
screen.

Observe the readings DX, DY and DZ indicating the
radius of the oval. When you are satisfied, press the left
mouse button to complete the oval.

If you wish to draw a regular polygon or change the
number of sides of the polygon, open the Control menu
and select Spin Step.

Select the regular polygon option you want or select
Number and enter the desired number. Press OK when

ready to confirm.

POLYLINES

Command to draw continuous lines.

Polylines work exactly like regular lines but, unlike regu
lar lines, continue drawing from the last point you pressed
the left mouse button.

To finish the polyline, press the right mouse button.

POLYGON

Command to draw irregular shapes.

POLYGON works the same way as Polylines, with the
exception that when you press the right mouse button, the
last point drawn will be connected with the starting point.
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CLOCKWISE ARC and

COUNTERCLOCKWISE ARC

Commands to draw clockwise and counterclockwise arcs.

Open the Tools menu and select ClockwiseArc. Position
the cursor where you want to define the first point of the
arc, then move the cursor and note that you can set the
center ofthe arc through movement of the cursor. Position

the center where you wish and press the left mouse button
to confirm.

See the dialog box with the angle selecting options. You
can enter the desired angle value and press OK to confirm
or select the Graphic Mode and click on to continue.

In the second case, observe the radial indicator rotating
around the center and the arc attached to the first point..
Set the second point as desired and press the left mouse
button to complete the operation. Note that you are now
in the polyline tool mode.

If you want to continue with arcs or any other poly tool,
open the Tools menu and select the new tool. Note that
the first point of the new tool will be attached to the last
point of the previous tool. If you want to stop, just press
the right mouse button.
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TEXT

Command to write three-dimensional text.

Master CAD text is made up of straight lines and works
like anyotherMaster CADobject. It canbe printed,even
plotted.

Open the Tools menu and select Text. Note that the
monitor disappears, and the message ENTER TEXTLINE
AND PRESSRETURN isdisplayed. Enteryourtext,press
return and you will see the message SETBASEPOINT.

Set the lower right corner of your text by moving the
cursor and click the mouse button to confirm.

DIM

This command creates dimensioning references of the
objects. Once you have selected DIM from the Tools
menu, select the DIM type and parameters from the dialog
box and press OKtoconfirm. The system will return to the
work-table and will give a set of instructions according to
the type of DIM tool selected.
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MODE

Menu for selecting the drawing system:

Fig. 195 Mode Menu

Mode

V Planes
Spin

PLANES

Menu to select theprojection mode. The projection mode
will define which polygons will be solid, and which
transparent.

You can see the result of the operations made with the
following commands when you use the Filled Planes
viewmode of the 3-D section.

When you have defined your projection planes or limit
planes you can use them in three different ways, alone or
combined.

196 Chapter 4 — Commands



—

_

U

_

_

Chapter 5: Commands

CUT: When you use the cut mode, the lines or polygons
that you draw in 2-D will be projected between the two
limitplanes andonly the planesprojected from these lines
or polygons will be solid.

Fig. 196

POLYGON
SECOND

LIMIT
PLANE

PLANES
PROJECTED

FIRST LIMIT PLANE

CUT MODE
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LOW CONTAIN: Whenyouusethismode,thelinesand
polygons drawn in 2-D will be projected only in the
farthest defined planes.

If you make a polyline while working in low contain
mode, it will function exactly like a polygon. If youwish
to create isolated lines contained in any limit plane, use the
Line tool.

Fig. 197

FIRST LIMIT PLANE

LOW-CONTAIN MODE
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HIGH CONTAIN: When you use this mode, the lines
and polygons drawn in 2-D will be projectedonly in the
nearest limit planes you have defined.

If you make a polyline while working in high contain
mode, it will function exactly like a polygon. If you wish
to create isolated lines contained in any limit plane, use the
Line tool.

Fig. 198

SECOND
LIMIT
PLANE

^ON
POLYGON PROJECTED

THE FIRST PLANE

FIRST LIMIT PLANE

HI-CONTflIN MODE
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HIGH CONTAIN +LOW CONTAIN: When youuse
this mode, the lines and polygons drawn in 2-D will be
PROJECTED IN BOTH LIMIT PLANES YOU HAVE
DEFINED, BUT THERE WILL NOT BE ANY PLANES
PROJECTED BETWEEN THEM.

Fig. 199
SECOND

LIMIT
PLANE

^

POLVGON PROJECTED
ON BOTH PLANES

FIRST LIMIT PLANE

LOM+HI CONTAIN MODE

If you make a polyline while working in this mode, it will
function exactly like a polygon. If you wish to create
isolated lines contained in any limit plane, use the Line
tool.
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CUT+LOW CONTAIN: When you use this mode, the
lines or polygons that you draw in 2-D will be projected
between the two limit planes and will be projected in the
farthest limit planes you have defined.

If you make a polyline while working in this mode, it will
function exactly like a polygon. If you wish to create
isolated lines contained in any limit plane, use the Line
tool.

Fig. 200

POLYGON

PLANES
PROJECTED

FIRST LIMIT PLANE

CUT+LOW CONTAIN MODE
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CUT+HIGHCONTAIN: When you usethis mode, the
linesorpolygons drawnin 2-D willbeprojectedbetween
the two limit planes and will be projected on the nearest
limit plane you have defined.

If youmake a polylinewhileworkingin this mode,it will
function exactly like a polygon. If you wish to create
isolated lines contained in any limit plane, use the Line
tool.

Fig. 201

POLYGON
SECOND
LIMIT
PLANE

PLANES
PROJECTED

FIRST LIMIT PLANE

CUT + HI CONTAIN MODE
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SPIN

Command to generate spun objects around a user-defined
axis.

Open the Mode menu and select Spin.

Fig. 202 Spin Dialog Box

Spin Selection

m .360 SPIN I

(P*
Clockwise SPIN I

m
CounterCW SPIN 1

OK ^ | CANCEL

You have three spin types to choose from:

360 SPIN: Command generates a spun object 360 de
grees around a user-defined axis.

Select 360 Spin and then OK to confirm. You will see the
message SET SPIN CENTER WITH CURSOR.

Position the cursor where you want the center to be, and
click the mouse button to set it. Observe the vertical axis

on the screen and the change in the VIEW reading. For
example, if you set the spin center in Plan you will see the
axis in Front.
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You can now use any of the Master CAD graphic tools to

make spun objects. For example, open the Tools menu
and select Rectangle. Place the cursor where you wish to
define the first corner of a rectangle and click the mouse
button to confirm.

Now place the second comer and click the mouse again.
You will see the message CREATING SPUN OBJECT
and the spun object developing on the screen. Open the
View menu and select the view you chose to define the
spin center. You will see a circular shape.

If you want to change the number of sides of the spun
object, open the Control menu, selectSpinStep, enter the
number of sides you wish, and select OK to confirm.

You can also set the spin center in any view. If you want
tochangeitjust open Mode, selectthespintypeandplace
the spin center where you wish.

By definition, a spun object (for select purposes) is created
by the action of one tool around the spin center. For
example, if you have drawn a line and a rectangle while
creating spun objects, you will have two of them.

CLOCKWISE or COUNTERCLOCKWISE SPIN:

Command to generate a spun object of n degrees around
a user-defined axis.

Select Clockwise Spin, for example, and then OK to
confirm. You will see the message SETSPIN CENTERBY
CURSOR. Position the cursor where you want the center
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to be, and click the mouse button to set it. Note the rotating
indicator around the spin center and the message SET
INITIAL ANGULAR POSITION. Set the indicator where

you want and click the mouse to confirm.

See the dialog box indicating the options for defining the
arc's angle opening by numeric input or Graphic Mode.
For the first option, simply enter the grade number and
click on OK to confirm. In the second case, select the
Graphic Mode and press OK to continue. Note again the
rotational indicator stemming from the center point. Now
you will see a new message, SETTHEFINALANGULAR
POSITION. Follow it using the cursor, and click the
mouse button to complete the setting.

In both cases observe the vertical axis on the screen and the

change in the View reading. You have defined a partial
spin structure and now you can use any of the tools as you
would in 360 Spin mode.

Fig. 203 Examples ofSpun Objects
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SELECT

Fig. 204 SELECT Menu

Select

Points
Elenents

Objects
fill

Deselect Points
Deselect Elenents
Deselect Objects
Deselect Oil

Reselect by Elenent

Menu to choose the Select or Deselect criteria you will
work with.

There are three types of "items" in the Master CAD
system: points, elements and objects.

POINTS

These are singular points that make up elements and
objects.

To select points, open the Select menu and then Points.
You will see the message SELECT POINT AND PRESS
RIGHT MOUSE BUTTON TO CONTINUE, and a cross-
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type cursor on the screen.

Now you must define a rectangle that contains the points
you want to select. Set the cursor where you want one
comer of the rectangle to be and click the mouse button to
confirm.

Move the cursor and note the broken-lined rectangle on
the screen. Position the cursor to locate the opposite
comer of the rectangle, and click the mouse button to
complete the selection of the points contained in the
rectangle.

Note: Triangular shapes indicate the selected points.

You can repeat the selection process as many times as you
wish. When satisfied, press the right mouse button to
return to the drafting board.

To deselect points, open the Select menu and then
Deselect Points. You will see the message SELECT
POINT AND PRESS THE RIGHT MOUSE BUTTON TO

CONTINUE, and a cross-type cursor on the screen.

The deselection process works exactly the same way as
the selection operation.
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Fig. 205

SELECTED POINT T
SELECTION RECTANGLE

ELEMENTS

These are straight lines or planes that make up objects.

To select, open the Select menu and then Elements. You
will see the message SELECT ELEMENTS AND PRESS
THE RIGHT BUTTON TO CONTINUE.

Position the cursor over the elements you want to select
and click the mouse button to confirm.

Note the triangular shapes that indicate the selected
elements.

You can repeat the selection as many times as you wish.
When satisfied, press the right mouse button to return to
the drafting board.
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To deselect elements, open the Select menu and then
Deselect Elements. You will see the message SELECT
ELEMENTS AND PRESS THE RIGHT MOUSE BUT

TON TO CONTINUE, and a cross-type cursor on the
screen.

The deselection process works exactly the same way as
the selection process.

Fig. 206

You can separate one element from one object, but if you
select this object the element will always be part of it.

REMEMBER: Only selected items may be processed.
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OBJECTS

These are sets of lines that make up any figure. They can
be selected and processed as a unit. Objects can be created
from figures includedin the Tools menu, or by combin
ing several of the above using the group process feature.

To select, open the Select menu and then Objects. You
will see the message SELECT OBJECTS AND PRESS
THE RIGHT MOUSE BUTTON TO CONTINUE.

Position the cursor over any side of the object(s) you wish
to select and click the mouse button to confirm.

Note the triangular shapes that indicate the selected ob
jects.

You can repeat the selection process as many times as you
wish. When satisfied, press the right mouse button to
return to the drafting board.

To deselect objects, open the Select menu and then
choose Deselect Objects. You will see the message
SELECT OBJECTS AND PRESS THE RIGHT MOUSE

BUTTONTOCONTINUE, and a cross-type cursor on the
screen.

The deselection process works exactly the same way as
the selection process.

You can combine different selection criteria as well. For

example, you can select an object, then deselect any points
from it, then select an element from another object, etc.

210 Chapter 4 —Commands



<
<

<
<

(
<

<
<

<
<

<
<

<
<

<
<

(
<

<
<

<
<

<
<

<
<

<
(
(
<

<
<

(
(
<

<
<

(
<

<
(
(
(
<

(

C
5

t
s

a
o

^
>

m o H m a O C
D

c
_

m o H

O
O

•S
3



Master CAD

PROCESS

Menu to choose the process to use on selected items.

•ymff-i
Group
Move
H-Flip
V-Flip
Copy
Rotate
Copy Rotate
Proportion

Fig. 208

Copy n
C Rotate n

Export
Delete

Show Area

Texture
Color

GROUP

Command to group the selected items into one integrated
object.

Open the Process menu and select Group.

REMEMBER: The process options function only on
selected items. Unselected (as opposed to deselected)
items will not be affected by the chosen process.
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MOVE

Command to move the selected items from one user-

defined position to another.

Select the items you wish to move, then open the Process
menu and select Move. You will see the message SET
INITIAL BASEPOINT POSITION and a cross-type cur
sor.

Place the cursor where you wish to define the basepoint,
or first point of reference. Click the mouse button to
confirm.

You will now see the message SETFINALBASEPOINT
POSITION. Move the cursor to where you want the new
point of reference to be, and click the mouse button.

You will see that all selected points have moved in the
direction marked by the two reference points, also in
proportion to the distance between the first point and the
second.

H-FLIP and V-FLIP

The Commands to flip the selected items horizontally or
vertically on a user-defined axis.

You can flip the items horizontally from right to left or
vice versa, depending on the flip axis position. You can
either flip the items vertically from top to bottom or vice
versa.

Select the items you wish to flip. To be sure that you have
selected them, open the Select menu, selectDeselectAll,
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mencarefully selectonly thoseitems youwish affectedby
the flip process.

Once the items have been selected, open the Process
menu and (for example) select theH-Flip option. You will
see the message SET THE FLIP AXIS and a broken
vertical line representing the axis.

Position the cursor where you want the axis to be and click
the mouse button to complete the operation and return to
the drafting board. Note the changed position of the item
selected.

Fig. 209
HORIZONTAL
FLIPPING
AXIS

/«• »\

• •
o o

o

^VERTICAL
V FLIPPING
^—y AXIS

o

•
\ /

COPY

Command to copy the selected items from one user-
defined position to another.

Select the items you wish to copy, then open the Process
menu and select Copy. You will see the message SET
INITIAL BASEPOINT POSITION and the cross-type
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cursor.

Place the cursor over the point where you wish the base-
point to be, and click the mouse button to confirm. You
will now see the message SET FINAL BASEPOINT PO
SITION.

Place the cursor where you want the copied position to be,
relative to the first point ofreference, and click the mouse
button to complete the operation.

You will see that all selected points have been copied to
the location marked by the second reference point, in
proportion to the distance between the first point and the
second.

Note: For the purposes ofthis process, all copied
elements will constitute an integrated object. As
before, only selected elements will be copied.

The new object will appear selected after the copying
process is terminated.
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Fig. 210

FIRST
BASEPOINT
POSITION

r\

COPIED —
BASEPOINT
POSITION _

ROTATE

Command to rotate the selected items in respect to a user-
defined axis.

The rotation is made from one user-defined angular posi
tion to another.

Select the item to be rotated, open the Process menu and
select ROTATE. You will see the message SET SPIN
CENTER and the cross-type cursor.

Position the cursor where you want to define the rotation
center and click the mouse to confirm.

See the dialog box indicating the options for defining the
rotation angle by numeric input or graphic mode. For the
first option, simply enter the desired angle value and click
on OK to confirm. In the second case, select Graphic
Mode and click on OK to confirm.
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Move the mouse, and note the indicator rotating around
the fixed point and the message SETINITIAL ANGULAR
POSITION. Position the indicator to set it and click the

mouse to confirm. Now you will see the message SET
FINAL ANGULAR POSITION and the indicator will

appear once again.

Now set the new angular position and click the mouse
button to complete the rotation.

To be rotated, an object must have all ofits points selected.

Fig. 211

FINAL
ANGULAR
POSITION

ANGLE

L£iif-
INITIAL
AHGULAR
POSITION
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COPY ROTATE

Command to simultaneously copy and rotate an item or
items in respect to a user-defined axis.

Copy rotation is done from one user-defined angular
position to another.

Select the item first, then open the Process menu and
select Rotate. You will see the message SETROTATION
CENTER and the cross-type cursor.

Position the cursor where you want the rotation center to
be, and click the mouse to confirm. Move the mouse, and
note the indicator rotating around the fixed point and the
message SET INITIAL ANGULAR POSITION.

Position the indicator to set the degree ofrotation and click
the mouse to confirm. You will now see the message SET
FINAL ANGULAR POSITION, and the indicator will
appear again.

Now place the indicator in the new angular position and
click the mouse to complete the copy rotation.

To be copy rotated, an element must have all points
selected.
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ORIGINAL
OBJECT

Fig. 212

SECOND
COPV

FINAL
ANGULAR
POSITION

ANGLE

:./\f-
INITIAL
ANGULAR
POSITION

COPYn

Command to copy the selected items n times. Each copy
is made from one user-defined position to another.

Select the items to be copied, open the Process menu and
select Copy n.

You will see the message SET INITIAL BASEPOINT
POSITION and the cross-type cursor.

Place the cursor over the point you wish to define as the
basepoint and click the mouse button to confirm.

You will see the message SET FINAL BASEPOINT PO
SITION. Place the cursor where you wish to define the
final basepoint. Click the mouse button to complete the
operation.
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You will see a dialog box that lets you select how many
copies you want, and, optionally, the relative perpendicu
lar distance between each copy.

Select DW and notice that you are working on a view
perpendicular to the view you were working on before.
Now you will see the message SETINITIALBASEPOINT
and a level indicator that lets you establish the first
reference level.

Move it to where you want and click the mouse button.
The message SET FINAL BASEPOINT will appear, as
well as the indicator to set the second reference level.

Move it to the desired position and click the mouse button
to confirm. You will then return to a dialog box where you
can start over again if you wish.

You will see that all selected points have been copied to
the location marked by the second reference point, in
proportion to the distance between the first point and the
second.

Note: For the purposes ofthis process, all copied elements
will constitute an integrated object. As before, only
selected elements will be copied. The new object will
appear selected after the copying process is terminated.
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Original
Obj ect

INITIAL
BASEPOINT
POSITION

+•

Firs*
Copy

Fig. 213

Sec and
Copy

•+-
FINAL
BASEPOINT
POSITION

Third
Copy

Fourth
Copy

COPY ROTATE n

Command copies and rotates n times the selected items in
respect to a user-defined axis.

Each item affected by this process is copied and rotated
from one user-defined angular position to another. The
relative angular difference from each copy to the next is
the same as that of the original to the first copy.

Select the item, open the Process menu and select
Rotate. You will see the message SETROTATION CEN
TER and the cross-type cursor.

Process Menu 221



MasterCAD

Position the cursor where you want the rotation center to
be and click the mouse button to confirm. Move the
mouse, note theindicator rotating around thefixed point,
and the message SETINITIAL ANGULAR POSITION.

Position the indicatorwhereyou wish andclick the mouse
button tosetit. Now youwillseethemessage SETFINAL
ANGULAR POSITION and the indicator will appear
again.

Move the indicator to the newangular position andclick
the mouse to confirm. You will seea dialog boxthat lets
you select how many copies you want and, optionally, the
relative perpendicular distance between each copy.

Select DW and notice that you are working on a view
perpendicular to the view you were working on before.
Nowyouwill see themessageSETINITIALBASEPOINT
and a level indicator that lets you establish the first
reference level. Move it to where youwantandclickthe
mouse button.

The message SET FINAL BASEPOINT will appear, as
well as the indicator to set the second reference level.
Move it to the desiredposition and click the mouse button
toconfirm. You will then return toadialog box where you
can start over again if you wish.

Ifyou are satisfied with the results, select OK and you will
see the copy rotated and the objects developing on the
screen.

To be copy rotated, an element must have all its points
selected.
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EXPORT

Command to export the selected items to another file.

For example, you may have a need to import elements or
items in a certain order to be able to process them properly.

Open the File menu and open your "library" file. Select
any object, open the Process menu and select Export.

Now open the file you want to work with by opening the
File menu and selecting the Import option. Notice the
objects imported from the "library" file on the centerof the
screen. Observe that they are selected: this is to let you
move and position them wherever you want.
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Fig. 215

Desk File Control View Planes Tools Mode Select |JJ-TJ4--HI 3-0

IvIEW:Plan Xi-Q.10
|_T00L:Line _Y: 11,90

DX: 0.00
DY: 0.00

« UP
« DOWN

J,00 DIST.:
0,00 JNGLE:

Group
Hove

H-Flip
v-Flip
Copy
Rotate

Copy Rotate
Proportion

Copy n
C Rotate n

Delete *

Show Urea

Texture

0,00
0,00

FREE:99Z
ZOOM:100i tJ

You can always checkon the exported items by opening
the CONTAINER.OBJ file.

DELETE

Command to delete the selected items.

Select the items you want to delete. Open the Process
menu and select theDelete option. You will see a dialog
box warning you about what you are about to do. Select
OKto delete the items. You can also Cancelif you wish,
and nothing will happen.

Be careful when using this command!
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SHOW AREA

Command to show the area of a defined polygon. A
defined polygon simply means that the polygon has been
defined; that is to say, it exists.

For the purposes of Master CAD, a polygon exists if you
can see it in Filled Planes. There are two ways to be sure
that a polygon is measurable:

Previous control: Drawing the polygon in Contain mode.

Checking: Seeing that the polygon has texture in Filled
Planes mode.

To show the area ofa defined polygon, select all its points,

open the Process menu and select Show Area.

You will see the message PRESS LEFT BUTTON TO
CONTINUE, RIGHT BUTTON TO EXIT. You will also

see the area of the polygon in the monitor.

Press the right mouse button to return to the drafting board.

TEXTURE

Command selects the texture of a defined polygon for
Filled Planes purposes.

To select the texture of a defined polygon, select all their

points, open the Process menu and select Texture. You
will see a dialog box with many texture options. Select the
texture you want and the system will return automatically
to the drafting board.
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Fig. 216 Fill Pattern Select Box

Shade Selection

• ••
;

1
KW^WAVJAW

MASTER SHADE

If you want to check the texture changes, open the 3-D
menu, select an appropriate viewpoint from which to see
the polygon, and open the Filled Planes viewmode.
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3-D MAIN MENU

FILE

Menu to select file operating system activities.

Fig. 218

FILE
Hew

Open
Append
Inport
Save
Save As

Draft Print
Save Screen

Quit

Functions are the same here as in the 2-D FILE Menu.

Refer to page 163.
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VIEWPOINT

Menu to select the conditions and parameters of the
viewpoint.

Fig. 219

VIEWPOINT
Horizontal
Vertical
Conbined
Autoview

Lens

HORIZONTAL

Command to define the observer's position and its hori
zontal viewing angle.

Create any object in the 2-D section. Open the 3-D menu
and note how the menu bar changes.

Open the Viewpoint menu and selectHorizontal. Notice
that you are now working in Plan view. You will see the
message SETHORIZONTAL VIEWPOINT and the cross-
type cursor.
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Position the cursor whereyou want andclick the mouse to
define thehorizontal viewpoint. Move themouse andyou
will see therotating line that indicates theviewing direc
tion, or view angle. You will see the message SET
HORIZONTAL VIEW ANGLE.

Define the view direction you want to use and click the
mouse to confirm. You will see the new perspective
developing on the screen.

VERTICAL

Command to define the observer's elevation and vertical
viewing angle.

Create any object in the 2-D section. Open the 3-D menu
and note how the menu bar changes.

Open the Viewpoint menu and select Vertical. Notice
that you are now working in Frontview. You will see the
messageSETVERTICAL VIEWPOINTand the level-type
cursor.

Position the cursor where you want and click the mouse to
define the vertical viewpoint (theheight of theviewpoint).
Move the mouse and you will see the rotating line that
indicates the viewing direction, or view angle. You will
see the message SET VERTICAL VIEW ANGLE.

Define the view direction you want to use and click the
mouse to confirm. You will see the new perspective
developing on the screen.
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COMBINED

Command to combine the Horizontal and Vertical view

point functions.

When you use this command the program will ask you to
set the horizontal viewpoint first, then the vertical view
point. It will then develop the new perspective or parallel
projection on the screen.

AUTOVIEW

Command that allows you to obtain an autocentered view
of the object you are working on.

Open theViewpoint menu and selectAutoview. You will
observe the perspective of the object developing on the
screen. Naturally, you will have to create the object in 2-
D before using this command.

LENS

Command modifies the viewangle width.

The Master CAD camera has three lenses you can choose

from by opening theViewpoint menu and selectingLen^.
You will see a dialog box with the following lens options:

NORMAL: This is the default lens and is equiva
lent to a 55mm lens.

WIDE ANGLE: Equivalent to a 28mm lens.

NARROW ANGLE: Equivalent to a75mm lens.
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Fig. 220 Select Narrow Angle..

Fig. 221 ...to tighten the view
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VIEWMODE

Menu activates the solid presentation of the objects.

Fig. 224

FILLED PLANES

Once you have created an object and have seen it in 3-D
wire frame mode, youcan see it as a solid by opening the
ViewMode menu and selecting Filled Planes.
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Fig. 225 Select Filled Planes

Desk FILE VIEWPOINT tWJ'Milil* PROJECTION Z-D

Fig. 226 Patternsfill the
Object Planes
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Master CAD has its own texture criteria for a given
polygon. If you do not like the texture selected by the
system, you can change it by using the TEXTURE process
in the 2-D section.

Fig. 227 To changefill textures

<3^
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F/g 22# Se/ecf //»e object, then Texture

Desk File Control View Planes Tools Mode Select l-Jil.H4.-H 3-D
Group
Move

H-Flip
v-Flip
Copy
Rotate

Copy Rotate
Proportion

Copy n
C Rotate n

Export
Delete

, ShoH Area
lt4MliUHa

vIEW:Plan X: 3.75

T00L:Rect. Yi-3,80

DX: 0.00

DY: 0.00

tt UP I 3,00 DIST.: 0,00 FREEI94* M
tt DOWN : 0,00 ANGLE; 0,00 Z00M:100 T

VIEW:PI an

T00L:Rect.

F/g 229 Se/ecf the desired texture

-4. J.-..

Shade Selection

• •••
1 | [ | R

MUSTER SHADE

X:-3.55
V: 4.00

DX: 0,00

DY: 0,00
tt UP : 3.00 DIST,: 0,00
» DOWN : 0.00 ANGLE: 0,00

FREEI94Z M
ZOOM:100 T
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Fig 230 Andobserve the results (Textures can also be changed
for individual Objectparts)
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PROJECTION

Menu to define the projection in which the object will be
represented.

PERSPECTIVE

The object is represented as it would appear in 3-D real
life. The effect is like a photograph taken from a given
viewpoint. This is the default mode. IfyouareinParallel
mode, open the Projection menu and select Perspective.
You will see the objects developing on the screen.

PARALLEL

Theobject isrepresented in 3-D or 2-D depending on user-
defined viewing angle. All parallel lines in real life will be
represented parallel in this mode.

For example, if you want to obtain an oblique (45-degree)
projection of an object, open the Projection menu and
select Parallel.

You will probably see a 2-D representation of the object.

Now go to the Viewpoint menu and select Combined.

Trace in your mind an imaginary 45-degree line that
passes through the center of the object, position the
viewpoint on any point on this line and click the mouse
button to confirm. Now set the view direction indicator for

45 degrees (using the Angledisplay in the monitor to help
you). Click the mouse to confirm. Repeat the operation
with the Vertical viewpoint. You will see an oblique
projection of the object developing on the screen.
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Thisprojectionalsoletsyouobtain2-Dviewsof theobject
from any point you want. For example, if you want to see
the shape of a building you have created, place the hori
zontal viewpoint facing the side the building and the
horizontal view angle perpendicular to that side. Repeat
the criteria with the vertical viewpoint and activate the
Filled Planes command.

You will see the shape of the object developing on the
screen.

2-D

Toggle to return to the 2-D main menu.
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OUTPUT

SECTION

The OUTPUT SECTION is designed to let you obtain
quality hardcopies of your work on printers and plotters.

You can access this section from the GEMDesktop (if you
are working on the DESIGN SECTION then open the File
menu and select the Quit option, Master CAD will bring
you to the Desktop).

From here select OUTPUT.PRG. The following dialog
box will appear:
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Fig 231

MasterCAD Hard Copy progran

u Qt

Select Printfile Preview Printfile

Hj
f= LOTTER

•}

| Begin Printing Begin Plotting

.

Setup

I PLOTTER 1 h- "1 h speed1 I — 1

SELECT PRINTFILE

Command to select the Master CAD PRINTFILES that

exist on disk.

These are special Master CAD files that you saved with
the Save Screen command from the DESIGN SECTION.

If you want to print or plot your work, you have to have
saved it in this format. These files are saved with a .PRF

extender.

To select a Printfile place the cursor over the SELECT
PRINTFILE icon and click the left mouse button once.

You will see a list of files which have the file extender

[.PRF]. You can load a file by typing the filename or by
double clicking on the filename from the file directory.

Observe the name of the current Printfile selected on the

upper part of the screen.
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BEGIN PRINTING

Command prints the selected Printfile.

Check that your printer is properly connected to your
computer.

Check that paper is correctly installed in your printer.

Place the cursor over the BEGIN PRINTING icon and

click the left mouse button to start the printout.

Master CAD is mainly compatible with the EPSON FX 80
or compatible printers. Master CAD is connected to the
G-DOS operative system so theoretically it is compatible
with any driver prepared for this OperativeSystem.

BEGIN PLOTTING

Command to plot the Printfile selected.

Check that your plotter is properly connected to your
computer.

Check thatpaper is correctly installed in yourplotter.

Place the cursor over the BEGIN PRINTING icon and
click the left mouse button to start the printout.

Master CAD is compatible with the Hewlett Packard™and
compatible plotters. This plotter in combination with
Master CAD produces high quality black and white
graphics in one size of drawing media: ANSI A (8 1/2 x
11in.). Other plotter drivers with more drawing sizes will
be released soon.
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MC DESKTOP

Command returns you to the GEM Desktop.

PLOTTER

This command selects the plotter driver to be used. Place
the cursor over the PLOTTER icon and click the left

mouse button. Observe the Select Plotter Window show

ing the different kind of plotters you can use. Click the
mouse over the desired PLOTTER Icon.

Fig. 232 Select Plotter Type

MasterCAD Hard Copy progran

Select Platter

a,

a

|Begin Printing Begin Plotting

|pr..3E -SIZEJ IpEM SPEEol
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PAGE SIZE

This command selects the size of the paper to be used with
the plotter. Place the cursor over the PAGE SIZE icon and
click the left mouse button. Observe the Select Size

Window showing the different size possibilities. Click the
mouse on the desired size icon. If the selected size is not

compatible with the previously selected Plotter, an Alert
Box will tell you.

Fig. 233 Select Size Window

PEN SPEED

This command selects the speed of the pen used by the
plotter. Place the cursor over the PEN SPEED icon and
click.with left mouse button. Notice the Speed Input
Window asking for the desired speed. Type it in using the
keyboard. If a PEN SPEED is selected that is not sup
ported by the selected plotter, a warning dialog box will
inform you.
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Fig. 234 Speed Input Window

MasterCRD Hard Copy progran

Set Pen Speed intfile

Plotter pen speed (1-80): L.

LjLi!
T

Begin Plotting

1

i^_ Setup

] F=^=l n^n

SCALE

This command selects the scale at which the PRINTFILE

will be printed or plotted.

Place the cursor over the SCALE icon and click the left

mouse button. Observe the SelectScale window showing
the different possible scales. Click the left mouse button
over the desired size icon, or type the input option and
press OK to confirm.
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Fig. 235 Select Scale window

MasterCAD Hard Copy progran

PRE'.' I EH

nm. '$
! Select intfile |

r-i--i

P

Default Scale 1:8

Hew Scale 1:8 L
cm i' i

Begin Printing Begin Plotting

I PLOTTER I Ipfl'JE sIZeI IpEN SFEEdI
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INSTALLING YOUR

PLOTTER

This section is designed to give you some examples on
how to install your plotter device properly.

Make sure that you have connected your plotter with your
computer using a "Null Modem" cable. (7-7, 2-3, 3-2
cable connection).

HEWLETT PACKARD™ COLOR PRO™

FIG. 236

Dip Switches I 0

R1 X
R? X

B3 X

R4 X

LIS x

R1 x

R? X

HEWLETT PACKARD™ 7550A GRAPHIC PLOT

TER
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Displays:

DATA FLOW

FIG. 237

PARITY

REMOTE

STANDALONE
PARITY

8-BITS OFF

BYPASS BAUD

BYPASSS ON

BAUD RATE

9600

HANDSHAKE MONITOR
HANDSHAKE MODE
Xon/Xoff DIRECT

MONITOR MODE
OFF

DUPLEX HP-IB

DUPLEX FULL
HP-IB ADDRESS

05

HEWLETT PACKARD™ 7550A GRAPHIC PLOT

TER

Installing a Plotter 249
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FIG. 238

INTERFASE MODE RS232-C

ON

- EVEN

- OFF

- ODD

1
PARITY

i

DUPLEX HALF - FULL

HARDWIRE - MODEM

DTR BYPASS - NORMAL

EXPAND - NORMAL

EMULATE - NORMAL

STANDALONE - EAVESDROP

MONITOR MODE - NORMAL

LOCAL - NORMAL

HP-IB PORT

COMPUTER/MODEM

TERMINAL

ill 111,::::::
wmm

iiilflllllllllll
•/,:•:•-•, •••-••

BAUD RATE : 9600 BAUD

NOTE : Use the functions
that appear in bold style.

NOTE : All this switches
are located on the back of
your plotter.

PLOTTING MULTIPLE PAGES

As you know, Master CAD PRINTFILES can be saved in
any scale you desire. In some cases this will cause
multiple page plotting. If you are plotting a multiple page
PRINTFILE, follow the screen instructions to determine

when to insert the next page.
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Master CAD

Menu to select operating system activities.

NEW OPEN APPEND IMPORT

SAVE-AS DRAFT-PRINT SAVE-SCREEN

SAVE

QUIT

Menu to select operating system activities.

ZOOM GRID UNITS

REVERSE-SCREEN REVOLUTION-STEP

SAVE

RULERS ON/OFF

Selects the orthogonal view you will work with.

PLAN FRONT BACK LEFT RIGHT

Menu to determine the type of projection plane to work with.

NORMAL PLAN-ANGLED FRONT-ANGLED SIDE-ANGLED

Selects the graphic tool you want to use for drafting.

LINE RECTANGLE CIRCULAR POLYUNE

POLYGON Clockwise ARC Counterclockwise ARC TEXT DIM

Menu to select the projection mode you will work with.
PLANES: CUT HI-CONTAIN LOW-CONTAIN

REVOLUTION: 360 CLOCKWISE COUNTER CLOCKWISE

Menu to choose the selection or deselection criteria.

POINTS ELEMENTS OBJECTS ALL

Menu to determine the type of process to use with selected items.

GROUP MOVE FLIP-HORIZONTALLY FLIP-VERTICALLY

COPY ROTATE COPY-ROT PROPORTION COPY-N

COPY-ROT-N EXPORT DELETE SHOW-AREA TEXTURE

:»:*::::™:™^

| Menu Command to switch to the 3-D Menu (See chart on page 255):

FILE VIEWPOINT VIEWMODE PROJECTION 2-D
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Menu used to observe and modify an object's perspective.

FILE VIEWPOINT VIEWMODE PROJECTION 2-D

JSSW:::™:::::::™

HORIZONTAL: Command to define through cursor movement,
the observors position and his horizontal viewing angle.

VERTICAL: Command to define through cursor movement, the
observors position and his vertical viewing angle.

COMBINED: Command that combines the function of horizontal
and vertical commands.

AUTOVIEW: Command that allows an auto-centered view of an
object.

LENS: Commands to modify the viewangle width.
mmmm^m

Command to activate the solid presentation of objects.

FILLED PLANES

Menu to define the type of projection that will be used.

PERSPECTIVE: The object in the space is represented as it
would appear in3-D real life. The effect is like a photograph taken
from a given viewpoint.

PARALLEL: The object is represented in3-D or 2-D depending
on the viewing angle defined bythe user. All the parallel lines in
real life will be parallel in this mode.

Command to return to two-dimensional drawing.

<<<<.:t:<<-:<<-mm^:v>>>v:wx>>X'>»:'S
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Command to reset all work parameters and restart with the default
conditions. It also creates a workfile from scratch.

Command to open a previously saved [.OBJ] file, it resets all parameters
and removes any information contained in RAM.

mmmiiiwjiiuu>utwwmu!u>j»»»q

Command to open a previously saved [.OBJ] file and append it to the
current file in memeory. It doesn'tresetthe current parameters. Checkthe
amount of available memory before starting this operation since Master
CAD will accept only the part of the appended file that it could fit in the
available memory.

g^^MBmW,MWMWmttWAW»««H»w

Command to import the exported objects from another file. Check the
amount of available memory before starting this operation since Master
CAD will accept only the part of the appended file that it could fit in the
available memory.

mmm

Command to save to diskthe objectscreated as a FILENAME.OBJ file. If
the file is previously saved with a user defined filename thiscommandwill
save it with this filename.

ww>Mmm>mmttii!Miitiitm!w.M

Command tosave todisk the objectscreated with a user defined filename.

Example: HOUSE.OBJ

Command to send a SCREEN DUMP to the printer.

Command to save the screen contents to different formats.

DEGAS FORMAT Example: HOUSE.PI3

MASTERCAD PRINTFILE Example: HOUSE.PRF
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n.MmmjvivnujjjnuviiiM.'iMjuujiijiiiiMviiijiiisiiiriiiissiiiinn*

Command to group the selected items as a single unique
object.

Com mand to move the selected items from a relative user defined
position to a new position also defined through cursor movement
by the user.

Command to flip the selected items horizontally, with respect to
a user defined axis.

Command to flip the selected items vertically, with respect to a
user defined axis.

Command to copy the selected items from a relative user defined
position to a new position alsodefined through cursormovement
by the user.

Command to rotate the selected items with respect to a user
defined axis. The rotation is madefrom the userselected angular
position to a new angular position also determeined by the user.

WMMMMmmm^

Com mand tocopy-rotate theselecteditems with respecttoa user
defined axis. Tne copy-rotation is made from the user selected
angular position to a new angular position also determined by the
user.

Reference Charts 255



Master CAD

Command to modify theproportion oftheselected items. The proportions
vary with respect to a user defined center.

Command to copy "N"times the selected items from a relative user defined
position to a new position also defined through cursor movement bythe
user. Thecopy follows the relative sequence between them determined by
the user.

Commandtocopy-rotate"N" timesthe selected itemswith respect to a user
defined axis. The copy-rotation is made from a user selected angular
position to a newangularposition also determined bythe user. The copy
follows the relative sequence betweenthem determined bythe user.

Command to show the area of a selected polygon

Command to select the texture for a selected polygon. It works onlyfor
filled plane purposes.

mmwm
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^^mmmmmmmmmmmm^m^^mmmmmmmmmmim^^mmtmM.
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Command totell thesystem thatyou are projecting between
the two user defined limit planes.
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APPENDIX A

Bibliography

THTRD YEAR PHYSICS
Dr. Jose Baldor

DESCRIPTIVE GEOMETRY
F. Izquierdo Asensi.

FUNDAMENTALS OF ENGINEERING DRAFTING
Warren J. Luzader

MATHEMATICAL ELEMENTS FOR COMPUTER
GRAPHICS

Lois Graff, Larry Joel Goldstein

COMPUTER DICTIONARY HANDBOOK
Third Edition. Charles J. Sippl and Roger J. Sippl

TECHNICAL DRAFTING MANUAL
Dr. Rafael Marquez
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PERSPECTIVE a new system for designers.
Jay Doblin
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Appendices

APPENDIX B

Installing Master CAD on a Hard Drive

To Install the Master CAD system on a hard drive simply
copy the disk contents into a folder in the C partition. You
can do this by inserting the MasterCAD disk into drive A:
then dragging the Disk Icon into the specified Hard disk
Partition. You can also drag the files individually (See
your Atari Manual for information on copying Disks and
files).

Master CAD can be installed in a folder, but the files
COLOR.RSC and MONO.RSC must remain in the root
directory of the partition.

Make sure GDOS is properly installed in the AUTO
folder of the Hard Drive. Also, as the program uses
GDOS for its output program, the AUTO folder and all
files that have a .SYS extension must be copied into the
root directory of Drive C.
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Index

2-D Menu 241

3-D Menu 26,248

360 degree spin 69,203
7550A GRAPHIC PLOTTER

248

Absolute X coordinate 10

Absolute Y coordinate 10

Absolute Z coordinate 11

ALT+HELP 168

printout canceled 168
ANGLE 12

Angle Selection 83,112
Append 166
APPLICATIONS 151

ASSIGN.SYS 261

Attention window 18

Autocentered view 231

B
BACK 11

BEGIN PRINTING 243

BIBLIOGRAPHY 260

Bottom limit plane 11
Buffer fde 167

Cartesian coordinate system
152

Cartesian space 162
Center of rotation 110

Central Conic Projection 149
Central Fugue Point

defined 156

Central projection 151
CLOCKWISE 204

CLOCKWISE ARC 193

Clockwise Spin 204
Color 180

Color PRO 248

Combined 239

Computer Aided Design 14,
162

CONCEPTS 148

Conic Projection 149
Conic system 151
Conical linear perspective

151

Contain Plane 12

CONTAINER.OBJ 166,224
CONTROL Menu 63,171

Zoom 171

Grid 173

Units 175

Origin 176
Reverse Screen 177

Screen Center 177

Spin Step 63,177
by input 179

Color 180

Input 180
Ruler 179

Coordinate System 152
COPY 101,102
Copyn 122,124,219
COPY n OBJECTS 121

COPY ROTATE n OB

JECTS 133

Copy rotation 218
COPY ROTATION n 138

COUNTERCLOCKWISE

204

COUNTERCLOCKWISE

ARC 193

Crosshair 28

CUBE.OBJ 109,121
CUT + HI-CONTAIN 146

CUT + HI-CONTAIN + LO-

CONTAIN 146
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CUT + LO-CONTATN 146

Cut Mode 54,197
defined 197

Cut Planes 12

CYLINDER 35

CYLINDER.OBJ 101

D
Delete 224

Deselect Points 207

DESIGN program 7
DESIGN SECTION 162

DESIGN.PRG 6

DIM 194

DIST 12

Distance 12

Distance Points

defined 156

DOWN 11

Drafting Board Monitor 12
DW option 126,139, 220,222
DX 11

DY 11

DZ 11

Elements 148,208
defined 157

Elevation 31

ENTER TEXT LINE 194

EPSON FX 80 243

Export 223

FEATURES 152

FILE menu 34, 56,1<W, 228
New 164

Open 166
Append 166
Import 167

266 Index

FILE menu (Cont.)
Save 168

Save As 168

Draft Print 168

Save Screen 169

D.E.G.A.S. format 169

Master CAD Printfile

169

Quit 170
Fill Pattern 226

Filled Planes 32, 225, 234,
240

Flip Elements 94, 213
FREE 12

FRONT 11

Front Angled option 58
Front Angled Planes

defining 185
Front limit plane 11,12
Front view 18,24,35,58,183,

188

Front-Angled Planes/Plan
Sub-Procedure 57

Fugue Point 158

G-DOS operative system 243
"GDOS 261

GEM Desktop 241,244 m

GENERAL VIEW 24,41 -

Graphic Mode 135,180,193 .'-^

Graphic ruler 180
GRID 9,173
Ground line 155

defined 155

Ground Plane 155 •

defined 155 •
Group 212
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H
H-Flip 96,214
Hard Drive

installation 261

Hexagon option 63
Hexagonal polygon 65
HEXAGONAL PRISM 57,

94

HI-CONTAIN + LO-CON

TAIN 146

High contain mode
defined 199

Horizon 155

Horizon Line

defined 155

Horizon Plane

defined 153

Horizontal Flip 96
Horizontal viewpoint 230,

231

I
Import 167
Input mode 180
Installing a Plotter 248

K
Keyboard mode 180

L
LEFT 11,50
Left view mode 16,25, 50
Lens 231

Limit planes 148
defined 156

Line 148,190
Line of sight 153
LOW CONTAIN 198

M
Menu Bar 9,15,18

appears 15
MODE menu 69, 78,144,196

Planes 196

Spin 69,79,203
Move 213

Moving the screen window
177

MT 12

N
NEW 164

Normal 36, 50,183
Normal Planes/Front

Sub Procedure 35

Normal Planes/Left

Sub-Procedure 50

OBJECTS 114,121,133,148,
157, 209

defined 157

Oblique 150,239
OBLIQUE PROJECTION

defined 151

Observer's elevation 230

Observer's plan position 29
Open 166
OPENING MENUS 15

Origin 176
ORTHOGONAL PROJEC

TION

defined 150

Orthogonal view 10,181
OUTPUT SECTION 162,

241

Select Printfile 242

Begin Plotting 243
Begin Printing 243

Index 267



Master CAD

OUTPUT SECTION (cont)
MC Desktop 244
Plotter 244

Page Size 245
Pen Speed 245
Scale 246

OUTPUT.PRG 241

P
Page Size 245
Parallel mode 239

Parallel projection 150,152
defined 148

Partial Spin 78
Pen Speed 245
Perspective 26,148,152,158,

239

defined 151

Perspective Projection 158
Picture plane 150,151,155
Plan 24

Plan Angled 184
Plan view 18,36, 57,70, 80,

146,156
Plane views 150

PLANES menu 18,19,36, 50,
58,183,196

Normal 19,183
Plan Angled 183
Front Angled 58,185
Side Angled 187

Planes Mode 21, 22,38, 62,
144

Planes Mode window 38, 54
PLANES option 144
Plotter 244

Plotting Multiple Pages 251
POINTS 94,101,109,148,

206

defined 157
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Polygon 117,192
fixing the center 63
form and size 65

POLYLINE 50, 55,73, 87,
192

PRF extender 242

Printfile 242, 243, 250
PROCESS Menu 98,102,

110,115,135, 212
Group 212
flip 213

horizontally 213
vertically 213

Move 213

Copy 214
Rotate 110,216
Copy Rotate 218
Proportion 114,115
Copyn 122,219
Copy Rotate n 221
Export 223
Delete 224

Show Area 225

Texture 225

Process commands 157

Projection 148,239
defined 148

PERSPECTIVE 239

Projection lines 148
Projection plane 151
Projection planes 183
PROPORTION 114,115

R
Rectangle 191
Rectangle option 22
Rectangles 148
Reference X coordinate 11,

12

Reference Y coordinate 11

.
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Regular Polygon 40, 63,191
Relative X coordinate 11

Relative Y coordinate 11

Relative Z coordinate 11

Remaining free memory 12
Reverse Screen 178

RIGHT 12

Right view 186
RING 73

Rotate 110,216
ROTATE ELEMENTS 109

Rotate n 135

Rotation indicator 137

s
Save As 34

Save Screen command 242

Scale 246

Screen Center 177

SELECT Menu 89,94,101,
109,114,121,133, 206,
210

Points 94,206

Elements 208

Objects 210
SELECT OBJECTS 89,114,

115,121,133
Select Plotter 244

SELECT POINTS 94

SELECT PRINTFILE 242

Select Scale 246, 247
Select Size 245

Selecting a viewpoint 159
SET BASE POINT 194

SET CUT PLANES 18,183,
184,187

SET FINAL ANGULAR

POSITION 83,137,
218, 222

SET FINAL BASEPOINT

POSITION 92,104,
124,127,140, 213, 215,
219, 220, 222

SET FINAL PROPORTION

118

SET GRID 174

SET HORIZONTAL VIEW

ANGLE 29, 230
SET HORIZONTAL VIEW

POINT 27,229
SET INITIAL ANGULAR

POSITION 82,135,
205, 218, 222

SET INITIAL BASEPOINT

POSITION 102,122,

126,139, 213, 214, 219,
220, 222

SET INITIAL PROPOR

TION 117

SET NEW ORIGIN 176

SET NEW SCREEN CEN

TER 177

SET PROPORTION CEN

TER 115

SET REVOLUTION CEN

TER BY CURSOR 70,
71,80

SET ROTATION CENTER

218, 221
SET SPIN CENTER WITH

CURSOR 110,135,
216,203

SET THE FINAL ANGU

LAR POSITION 205

SET THE FLIP AXIS 214

SET THE SCREEN CEN

TER BY CURSOR

173

Index 269



Master CAD

SET VERTICAL VIEW

ANGLE 230

SET VERTICAL VIEW

POINT 230

Show area 225

Side Angled planes 187
setting 187

SPIN 69,
Spin center 70
SPIN STEP 63,178
Spun figure 74

T
TEXT 194

Texture 225

Three dimensional 227

TOOL 10

TOOLS Menu 22,40,55,63,
73, 83,190

Clockwise Arc 83,193
Counterclockwise Arc

193

Line 190

Rectangle 191
Regular Polygon 191
Polygon 192
Polyines 192
text 194

Dim 194

Two menu bars 16

u
Unit Selection 176

Units 175

Upper limit plane 11
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V
V-FLIP 98,213
Vanishing Plane 155

contains the viewpoint
155

defined 155

vertical plane 155
Vertical Flip 98
Vertical spin axis 83
Vertical viewpoint 230, 231
VIEW 10,15, 24,181
View Angles 153

defined 153

View direction 230

View indicator 80

View menu 35,50, 57,181
Plan 57

View plane 183
View projection plane 187
VIEWMODE 32, 234

FILLED PLANES 234

VIEWPOINT Menu 27,31,
152,155, 229

Autoview 231

Horizontal 27,229
Vertical 31,230
Combined 231

Lens 231

Normal 231

Narrow Angle 231
Wide Angle 231

w
Window

moving 177
Workscreen 9,18,31

drawing space 9
Workspace 148

size 162
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X coordinate 10,11

Y coordinate 10,11

z
Z coordinate 11

ZOOM 12,171
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TMCome and join us at the Roundtable,
TM

Where the GEnie and the Griffin meet!

Does this sound like a fantasy? Well, it may just be a dream come true!
When General Electric's high-tech communications network meets
MichTron's programmers and support crew, ST users around the
country will hear more, know more, and save more.

We know that our low prices and superior quality wouldn't mean as
much to youwithout thepropersupportand serviceto back themup.

So we are now available on GEnie, the General Electric Network for
Information Exchange. GEnieisacomputercommunications system
which lets you use yourpersonal computer, modem, and communica
tion software to gain access to the latest news, product information,
electronic mail, games, and MichTron's own Roundtable (See the
special MicroDeal Section for game information)!!

The Roundtable Special Interest Groups (SIG) gives you a means of
conveniently obtaining news about our current products, new re
leases,andfutureplans. Messages directlyfromtheauthorsgiveyou
valuable technical support of our products, and the chance to ask
questions (usually answered within a single business day).

GEnie differs from other computer communication networks in its
incredibly low fees. With GEnie, you don't pay any hidden charges
or minimum fees. You pay only for the time you're actually on-line
with the MichTron product support Roundtable, and the low first-
time registration fee.

For more information on GEnie, follow this simple procedure for a
free trial run. Then if you like, haveready yourVISA, Mastercardor
checking account number and you can set up your personal account
immediately — right on-line!

1. Set your modem for half duplex (local echo)—300 or 1200
baud.

2. Dial 1-800-638-8369. When connected,type HHHand press
Return.

3. At the U#= prompt, type XJM11957,GENIE and press Re
turn.

And don't forget, MichTron's Bulletin Board System, The Griffin
BBS, is still going strong (the griffin is the half-lion/half-eagle
creature on our logo). Our system is located at MichTron headquar
ters in Pontiac, Michigan. For a trial run, call (313) 332-5452.

GEnie and Roundtable are Trademarks of General Electric Information

Services.
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